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VinylStudio Quick Start Guide
VinylStudio's view of the world looks like this:

As you can see, VinylStudio organises your recordings in a collection. You don't need to open, edit and save audio files in the way you
might be used to. The only time you might do this is when you import an existing recording into your collection. After that, you just
select the file you want to work on from a dropdown list and VinylStudio will take care of the rest. You can create as many collections as
you like, but you must create at least one. VinylStudio will prompt you to create a collection when it first starts up. You can create
another one any time you need it via Menu -> File -> New Collection.
Within a collection, VinylStudio stores your recordings as a list of albums. These are recorded a side at a time and these recordings are
then split up into individual tracks which can then be played on your PC, downloaded to an MP3 player or iPod, or burned to CD. You can
also elect to remove clicks, hiss, hum and rumble before you save your tracks and there is also a graphic equaliser. VinylStudio can also
digitise singles and the spoken word.

VinylStudio is not an Audio Editor
It is important to realise that VinylStudio is not an audio editor. That is to say, it does not directly edit your recordings or any audio files
you might have imported. Instead, VinylStudio is 'non-destructive'. Any changes you make within the program are stored separately and
then 'overlayed' onto the original audio when you save your tracks or burn CDs. Consider VinylStudio as a decision-making tool, where
you can change those decisions later if you choose. Your original recordings are never altered.
This, once you get to grips with it, is a big plus. You do not, for example, have to worry about keeping both original and cleanup-up
copies of your recordings. It also means that if you change your mind about something (perhaps you overdid it with the hiss filter) you
can go back into VinylStudio, make whatever changes you feel appropriate and then save your tracks again (or burn another CD).
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VinylStudio Step-by-Step
1. You first need to hook up your turntable or tape deck to your PC and check that it is working correctly. This is covered in more detail
here. Don't miss the section entitled 'Testing your Setup' near the end. The golden rule is that you need to see the recording level
indicators moving in time with the music (and not stuck on maximum, for example).
2. VinylStudio has five main working areas, which you select by clicking on the tabs at the top of the VinylStudio window:

3. To record an album, click on the Record tab (if necessary) which will take you to the Record window where you can enter the artist
and title of the album you wish to record. Albums are recorded one complete side at a time and you should record both sides of the
album before you proceed to the next step. Alternatively, if you have already recorded the album in another program, you can import an
existing recording. You can also record singles, or other material with no trackbreaks.
4. While your album is recording, you can lookup or type in the album's track listing. With luck, you will be able to find a track listing online.
5. Once you have a recording to work with, you need to split it into tracks, which you do in the Split Tracks window. Please note that
no additional files are created at this point (this happens later on). You are merely telling VinylStudio where the tracks begin and end. We
recommend you start with an album you know well, as this makes the task a good deal easier.
6. You can also, if you wish, removes clicks, scratches, hiss and hum from your recordings. This step is optional, but often worthwhile.
VinylStudio does not make any changes to your original recordings when you do this, so feel free to experiment. And if you decide, when
listening to a CD you have made, that these features might be worth a try after all, you can always give them a whirl and then burn
another CD. Declick your recording (if it needs it) before applying any of the other filters for best results.
7. When you are happy with the results of your work, you can burn CDs and/or save your tracks as individual, tagged files. These files
can be played on any computer (using Windows Media Player or iTunes, typically) or copied to your iPod or MP3 player. VinylStudio for
Macintosh can also save tracks in AAC (MP4) format.

A couple of things worth knowing
Most actions in VinyStudio can be undone with the Undo / Redo buttons in the toolbar

(Ctrl+Z / Ctrl+Y).

VinylStudio can record to, and work with, files in a variety of formats. Uncompressed formats (such as WAV) provide the best
performance and musical fidelity while a compressed format (such as MP3) is much more economical on disk space. See here for more
information.
As of version 8, VinylStudio provides additional tools for keeping track of your collection as it grows. The are:
album status - a value such as Recorded or Cleaned, which reminds you of the stage you have reached for each album you have
recorded
sort or filter the album list - to help you locate an album in your collection quickly and easily

Connecting up your Turntable or Tape Deck
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Connecting a Turntable to your PC
Recording Cassettes
Recording Reel-to-Reel
Hooking up your Computer's Speakers
Testing your Setup
Using a Laptop

C onnecting a T urntable to your P C
To record vinyl albums (or 78s) you will need to hook up your record deck to your sound card or other input device. This can be achieved
either by running a cable from your Hi-Fi, or by using a Phono Pre-amp (which you will have to purchase separately). You can also use a
USB turntable or cassette deck if you have one.
In all cases, you can monitor what you are recording through your computer's speakers.
If you are using a Hi-Fi
If your turntable is already connected to a Hi-Fi, there should be a phono socket on the back labeled REC OUT, or TAPE REC or similar (if
you have a tape deck connected to your Hi-Fi, this socket will be in use, so you will need to disconnect it). Run a cable from this socket
to the the line-in socket (usually colour-coded blue) on your sound card. The cable you need is a 3.5mm Jack to Twin Phono Lead:

If you are using a Phono Pre-amp
If you are using a Phono Pre-amp, you will need a similar cable; run it from the output of the pre-amp to line-in on the sound card. In the
UK, Phono Pre-amps can be purchased from Maplin Electronics at moderate cost. In the US, try www.phonopreamps.com. Connect the
flying leads from your turntable to the input of the preamp.

If you are using a USB turntable or other USB device
If you are using a USB turntable or other USB device, VinylStudio should recognise it the first time you plug it in to a USB port. If it does
not, open the Check Level dialog and select your device (usually 'USB Audio CODEC') from the drop down list. Do not be put off by the
fact that some USB devices identify themselves as a Microphone - they are lying.
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R ecording C assettes
If you have a conventional cassette deck, you can run a cable like the one pictured above from the output sockets on your tape deck to
the line-in socket on your sound card (normally colour coded blue).

Another, very simple way to record cassettes is to use a personal cassette player (walkman) and run a cable from the headphone socket
to the line-in socket on your sound card. This usually gives surprisingly good results. The cable you need has a 3.5mm / 1/8th inch male
jack on each end and is not hard to obtain. Again, try Radio Shack in the US or Maplin Electronics in the UK. Plug one end of the cable
into the headphone jack on the tape player and the other into your PC.

If you are using a USB cassette deck or other USB device
If you are using a USB cassette deck or other USB device, VinylStudio should recognise it the first time you plug it in to a USB port. If it
does not, open the Check Level dialog and select your device (usually 'USB Audio CODEC') from the drop down list. Do not be put off by
the fact that some USB devices identify themselves as a Microphone - they are lying.

R ecording R eel-to-R eel
The easiest solution here is to run a cable like the one pictured above from the output sockets on your tape deck to the line-in socket
on your sound card (normally colour coded blue). Again, you can monitor what you are recording through your computer's speakers.

Hooking up your C omputers Speakers
Most PCs already have speakers attached so there should be no problem here, but some USB devices change the default playback device
(to themselves) when they are plugged in for the first time which means that, in effect, your speakers stop working. If this happens to
you, you can change the playback device VinylStudio uses from the Change Playback Device dialog under the Options menu. You can
also reset the default playback device (as used by all other applications) by clicking on Change Default Playback Device in this dialog.
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T esting your Setup
To check that everything is correctly hooked up, start a record or tape playing, go to VinylStudio's Record Albums window and click on
the Check Level button. You should then see the recording level indicators moving in time with the music:

If you check the 'Monitor Recording' box (or sometimes even if you don't), you should hear what you are recording played back through
your computer's speakers.
If no sound is getting through, a bit of experimentation might be needed:
double-check your connections
try selecting a different Input Source in the dropdown box
try selecting a different Sound Card in the dropdown box (XP only)
check that the recording level slider is not set at zero

Using a Laptop
Laptop computers are not always suitable for recording as many only have a microphone input, which is mono. The easiest way to tell if
this is the case is to make a short recording and listen to it on headphones. If you need one, you can buy a USB sound card, such as the
Griffin iMic, or even a phono-preamp equipped with a USB connection such as the NAD PP-3 or PP-4. If you are using a USB turntable,
there is no problem recording on a laptop.
Please note that the iMic is not compatible with Windows Vista.

Recording Albums
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The essential steps to record an album are as follows:
ensure that your turntable (or tape deck) is hooked up correctly to your PC
check that your setup is working
set the record level
enter the artist and album title
start recording
Albums are recorded one complete side at a time and, usually, VinylStudio will stop recording when your record deck lifts the needle at
the end of an album side.
For more details, please refer to the following sections within this help page:
Setting the Record Level
Recording an LP
While you are Recording
Recording Side 2
Recording from Tape
Setting the Needle Down Level
Speed Conversion
Using Software Recording Equalisation (VinylStudio Pro only)
Using ASIO
Loopback Recording (VinylStudio Pro only)
Recording in DSD Format (VinylStudio Pro only)
Notes

Setting the R ecord Level
Start the record or tape playing and then click on the Check Level button. If all is well, you should see the recording level indicators
moving in time with the music (you may need to select the correct input device and (on XP) source line in the dropdown boxes first time
through):
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While the album is still playing, adjust the recording level using the slider. The recording level indicators should just enter the red zone on
the loudest sections of music. If the indicators flash completely red, you definitely need to reduce the recording level.
If you cannot get the recording indicators to move in time with the music, you will need to check that you turntable (or tape deck) is
hooked up to your PC correctly. There are some details on how to do this here.
If you wish to record in DSD format, see also Recording in DSD Format
If you are using Windows Vista or later, the Check Level dialog looks a little different:

in this case, select your input device from the Input Device dropdown and leave Use WASAPI enabled unless you have difficulties, in
which case please try unchecking it. WASAPI is a Windows technology that offers a cleaner signal path when recording and is this
recommended if you can use it.
If you have a USB device on Windows Vista or later, the Check Level dialog might look like this:
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In this case, you should use the 'Set Digital Gain to 1` button to set the recording level. This gives the best dynamic range and minimises
the risk of clipping. The important thing to note is that the recording level on your USB audio device is not adjustable. The slider just
boosts or cuts the gain after the signal has been digitised, and either of these actions is undesirable. If you need to boost the playback
level after recording, you will find the tools to do it in the Graphic Equaliser window.

W hy is T he R ecording Level Slider Disabled?
Some USB devices, notably the Ion USB Turntable and the NAD PP-3 / 4 phono pre-amp, have no software level adjustment. There is
nothing VinylStudio can do about this as any clipping which occurs happens before the signal reaches the computer. Some Ion USB
turntables have a manual control on the back of the unit and some USB phono preams have a gain control. The NAD is calibrated for
most popular cartridges and implements something called 'soft clipping' which reduces the severity of the distortion that clipping
introduces.
If this is a major bugbear for you, you might consider disconnecting the USB cable and running a cable from line out on the USB device
(most USB devices have one) to line in on your computer's soundcard instead. VinylStudio's normal level control will then become
available. The cable you need is a 3.5mm Jack to Twin Phono Lead as pictured here.
If you need to boost the playback level after recording, you will find the tools to do it in the Graphic Equaliser window.

R ecording an LP
Once everything is connected and working, note the following area of the Record window:

To record an album:
Lift the needle (important!).
Close the Check Level window, if it is open.
Ensure that 'Record or import a new album' is selected as shown above.
Click Record.
The following dialog is then displayed (shown with some fields filled in):
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To start recording:
Enter the artist and album title for this album (required) and any other relevant information.
Click Record.
When VinylStudio asks you to, lower the needle.
Recording should then start. If it does not, see setting the needle down level below.
Notes:
If you want VinylStudio to record all album sides as one file (which makes for somehwat easier audio cleanup), check the box.
VinylStudio will then pause recording at the end of the album side so that you can turn the record over and resume recording.
If you are recording a single (or other material with no trackbreaks) check the This is a Single box.
If you want VinylStudio to save tracks for this album in mono, check Mix down to mono. The actual recording will still be made in
stereo because the declicker works better.
The recording level indicator can operate either in % (the default) or in dB. Click on the 'peak level' indicator above the recording
level indicators to toggle between the two.
If VinylStudio reports an error when you try to record, visit the Check Level dialog and check 'Limit playback to 16 bit'. Certain USB
devices, notably the Furutech ADL GT40 and the Creative Sound Blaster Surround 5.1 USB, cannot simultaneously play back and
record at higher sample rates and bit depths and therefore need this option set. On Windows Vista and later you should set the
Default Format to 2 channel, 16 bit, 44100 Hz (CD Quality) in Control Panel -> Sound -> Playback -> Properties -> Advanced if you
have one of these devices and 'Use WASAPI for playback' in the Change Playback Device dialog is not in effect for some reason.
The information you enter here can be changed later in the via the Edit Album Details button in the Split Tracks window.

W hile you are R ecording

To listen to what you are recording, check the Monitor Recording box. The sound might be slightly choppy on low-end machines or if
you run other applications while recording, but your recording is not affected. Uncheck this box if you hear an echo (again, your
recording is not affected). Use the Monitor Volume button to change the monitor playback level - again this does not affect the
recording in any way - and use the Change Playback Device button to select a different playback device if no sound is coming from
your speakers.
If your record deck lifts the needle or stops the turntable at the end of the record, recording will stop automatically. Alternatively, you
can select a maximum recording time from the dropdown list.
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If the 'clipped' counter starts to mount up while your are recording, consider reducing the recording level and re-recording as loud
passages of your recording may sound distorted.
You can edit the track listing for the album you are recording it (or you can do this later - it's up to you). To do this, click on the Edit
Track Listing button which will take you to the Split Tracks window. To return to the Record window at any time, click on the Record
tab at the top of the window.
You can also insert a trackbreak while recording by pressing B, or a marker by pressing M. These will become visible when recording is
complete. You can do this from both the Record and Split Tracks windows. Note that the B key works best if you delete any existing
trackbreaks before you start recording.

R ecording Side 2

To record side 2 (or 3 or 4) of an album:
Ensure that 'Work with an album added previously' is selected.
Select the appropriate side from the drop-down box (i.e. side 2, usually).
Click on Record.
You can first select the album you wish to record from the drop-down list if needs be and you might like to use Check Level to set the
recording level (although two sides of the same LP don't usually vary that much).

R ecording from T ape
To record from tape, the procedure is the same as described above but if the music fades in gradually, VinylStudio might miss the start of
it when the Wait for Needle Down box is checked. If this happens to you, uncheck this box. VinylStudio will then start recording as
soon as you click on the Record button, but it also prevents VinylStudio from stopping automatically at the end of the tape (so set a
maximum recording time instead).

Setting the Needle Down Level
If you check the Wait for Needle Down box, VinylStudio will wait for you to lower the needle before it starts recording and, as long as
your record deck has an automatic tone arm, it will stop recording automatically at the end of the record.
The default Needle down level setting of 5% works in the majority of cases, but you might need to adjust it if:
a. VinylStudio does nothing when the needle hits the record surface, or:
b. VinylStudio reports that 'the needle appears to be already down' when you click on the Record button
For case (a), start the record playing and use the Check Level button to ensure that the recording level indicators are moving in time
with the music. If they are not, you need to sort the problem out before you can record anything.
For case (b), you can increase the Needle Down Level setting and try again, but the real problem might be that there is a high level of
background noise (typically mains hum) and you might look into this first. Also, it is essential that you do not lower the needle until
VinylStudio asks you to.
If VinylStudio stops recording between tracks, rather than at the end of the record or tape, try increasing the Needle up timeout
setting.
As mentioned above, when recording tapes you may get better results if you uncheck the Wait for Needle Down box and set a
maximum recording time instead.

Speed C onversion
If you wish to record 78's on a turntable with no 78 RPM speed setting, check the Speed Conversion box and set the record and
turntable speeds appropriately. We recommend recording 78's at 45 RPM (rather than 33), as this preserves more of the bass notes. You
can also record 33's at 45 RPM to save time, but you will lose a little treble by doing so.
If you are using speed conversion when recording records, we recommend enabling recording equalisation in the Check Level dialog. This
enables VinylStudio to compensate for the change in turntable speed (which affects the RIAA equalisation built into your phono preamp).
See below for more details.
For tapes, type numbers in the boxes as shown in the following table:
Normal playing speed of tape Running speed of tape deck Set 'Tape' box to: Set 'Deck' box to:
1 7/8 ips

3 3/4 ips

10

20

1 7/8 ips

7 1/2 ips

10

40
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1 7/8 ips

15 ips

10

80

3 3/4 ips

1 7/8 ips

20

10

3 3/4 ips

7 1/2 ips

10

20

3 3/4 ips

15 ips

10

40

7 1/2 ips

1 7/8 ips

40

10

7 1/2 ips

3 3/4 ips

20

10

7 1/2 ips

15 ips

10

20

15 ips

1 7/8 ips

80

10

15 ips

3 3/4 ips

40

10

15 ips

7 1/2 ips

20

10

For best results, set the deck speed as close as possible to the tape speed. Faster deck speeds will save you time but cost you treble
which the graphic equaliser can only partially correct.

Using Software R ecording Equalisation

VinylStudio has a software recording equalisation feature which can either be applied at record time or after recording is complete. When
you apply recording equalisation at record time, VinylStudio maximises the dynamic range of your recording by running your recording
device at the highest possible bit depth, regardless of the recording format you are using. You can therefore use software equalisation
effectively even when recording at 16 bits per sample (which you might want to do to conserve disk space). It also has the advantage
that you see the equalised signal in the waveform display.
Recording equalisation is enabled in the Check Level dialog. When you change this setting, the recording level will also change, so make
sure this is correct before you start recording. For discs cut from 1954 onwards, the RIAA preset should generally be used. For earlier
discs, VinylStudio comes with a large number of preset curves but selecting the right one can be a challenge. Try consulting the sleeve
notes or plug in a decent set of headphones and adjust the parameters by ear. Increasing the bass turnover frequency will boost bass
notes. Increasing the 10kHz rolloff value will cut treble. You can save your settings as a preset, and you can also enter time constant
values if that is the information you have.
When using recording equalisation, use the 'flat' switch on your phono preamp if it has one. If it doesn't, check the 'Apply inverse RIAA
first' box. You should use VinylStudio's recording equalisation if speed conversion is enabled, even if your preamp has no flat switch. The
change in turntable speed will fool your preamp into applying the wrong curve and VinylStudio corrects this. For older 'acoustic'
recordings which require no equalisation at all, just select 'Inverse RIAA' from the dropdown box if your phono preamp has no 'flat' switch.
If you are recording via a Graham Slee Accession preamp set to CA/FLAT, the procedure is slightly different. If you are recording a disc
that uses standard RIAA equalisation, just select 'Inverse Accession CA/FLAT' from the dropdown. If, on the other hand, you are
recording an older disc that requires a different equalisation curve, select that from the dropdown instead and check the 'Apply Inverse
Accession CA/FLAT and Inverse RIAA first' box.
The equalisation curves built into VinylStudio were taken from the Audacity wiki,
http://wiki.audacityteam.org/wiki/78rpm_playback_curves and references therein, with much thanks. You can also enter the parameters
yourself for certain curves by looking them up at Vinyl Engine: www.vinylengine.com/cartridge_database_record_equalization.php.
The Inverse Accession CA/FLAT curve is supplied courtesy of Graham Slee, see:
www.alpinesoft.co.uk/VinylStudio/accession_ca_flat.aspx.

Using ASIO
If you wish to use an ASIO driver, open the Check Level dialog and select ASIO from the first dropdown list. You can then select your
ASIO driver (there is normally only one) and mappings for the left and right channels (again, the defaults will normally do).
If you experience 'dropouts', try increasing the buffer size in the ASIO control panel. You may also find level controls in here. The
appearance of the ASIO control panel varies from device to device.
You can also use ASIO as your playback device if desired. To do this, select 'Change Playback Device' from the Check Level dialog and
select ASIO in the first dropdown list. Please note that if you are using ASIO4ALL, you will probably need to set it as both the recording
and playback device.

Loopback R ecording
From Windows Vista onwards, VinylStudio supports loopback recording - i.e. it can record whatever is playing through your computer's
speakers. To enable this, just select 'Loopback' in the Input Device dropdown in VinylStudio's Check Level dialog.
Please note the following quirks when using loopback:
The recording level is actually set by the playback volume slider in the app (e.g. Windows Media Player) that is playing the audio
you want to record. The recording level slider in VinylStudio is therefore disabled.
-- 13 --

You cannot monitor your recording while using loopback, so keep your speakers turned on.
VinylStudio can only record from the default playback device.
VinylStudio will record any bings and bongs that your computer makes, so you might like to shut down (e.g.) your email program
while you are recording.
Loopback recording won't work if you are playing your audio via ASIO.

R ecording in DSD Format
(VinylStudio Pro only).
If you have an ADC which supports DSD over PCM, VinylStudio can now record DSD files. To configure VinylStudio and your ADC to record
DSD, proceed as follows:
1. Select DSD on the front panel of your ADC.
2. Open VinylStudio's Check Level dialog.
3. Select your device in the Input Device or ASIO Device dropdown. On Windows, ASIO is often the best choice.
4. Select your desired DSD sample rate in the 'DSD Input' dropdown (standard rate strongly recommended).
5. You may also need to set the recording level slider to maximum. Do this before selecting ASIO.
Ensure also that 'Enable DoP Detection is enabled in the Recording Options dialog (it is, by default).
On Windows Vista and later, if you are unable to use WASAPI for recording for some reason you can get away without it, but you must
then set Windows' shared recording format in the Sound section of the Control panel as follows:
DSD single rate: 176.4 kHz, 24 bits per sample, stereo
DSD double rate: 352.8 kHz, 24 bits per sample, stereo
WASAPI is usually available (and functional) however.
Please note that DSD can only be recorded to lossless audio files (so not MP3, for example), and that you will need a fast computer (23GHz+) to work with them. Also, VinylStudio's editing features do not work with them, including:
RIAA equalisation when recording
declicking and patching
filters (hiss, hum, rumble, graphic equaliser, normalisation and equalisation curves / FFT filter)
fading tracks in and out
mix down to mono
You can however use these features (except for the first and last) if you save your tracks as PCM or when burning audio or data CDs or
DVDs. However, VinylStudio also supports saving DSD recordings as DSD, which is a bit-transparent operation and ignores any edits you
might have made. Sorry about that, but DSD is not an editable format, simple as that.
DFF, DSF, CAF, FLAC and Apple Lossless files have no practical limitations, and recording to DFF or DSF files is to be preferred as the files
are 2/3 the size of the corresponding WAV or AIFF files. Note that you can still save your tracks as DoP (DSD over PCM) in WAV, AIFF,
FLAC, Apple Lossless or CAF files if that's what your player needs.

Notes for Users of the P S Audio NuW ave P hono C onverter W hen R ecording DSD
There are currently some issues with this device which you need to be aware of to make successful DSD recordings. As a result, you
must:
1. Select the PS Audio 'native' (not ASIO) driver in the 'Input Device' dropdown.
2. Set the recording level slider to maximum (important!).
3. Under Windows, then choose ASIO in the Input Device dropdown of the Check Level dialog and select the PS Audio ASIO driver in
the 'ASIO Driver' dropdown if necessary.
There are severe issues with the PS Audio recording DSD on Windows XP which cause VinylStudio to misbehave or crash so please don't
try it; this situation is unlikely to change.

Notes
If you wish to import an existing sound file (e.g. a recording made in another program), you will find details here.
If you are short of disk space, you might want to record to a compressed file format (such as MP3). More information can be found here.
VinylStudio automatically sets the album status to 'Recorded' when recording is complete (even if you have recorded only side 1).

R ecording Singles and 78s
The easiest way to record singles or 78s is to add each side of each single or 78 to your collection as a separate album and check the
This is a single box in the Record window. VinylStudio will then:
automatically add a track with the same name as the album title (which is generally what you want)
save this track (by default) in a folder called singles when you save your tracks (i.e. all such tracks go in the same folder)
Thus, for example, if you wanted to record Elvis Costello's Watching the Detectives, you would:
1. Check the This is a single box in the Record window
2. Add an 'album' to your collection with artist Elvis Costello and title Watching the Detectives; bear in mind that this album will
consist of just the one track
3. Record the single (just the one side)
4. Tidy up the start and end markers for the track in the Split Tracks window window (to trim off the needle drop, lead in, lead out
and needle lift)
This process is then repeated for the B side, and so on for your other singles until you have enough tracks recorded to burn a CD or save
your tracks.
For EP's (remember those?), you can do the same thing and add the second track on each side manually in the Split Tracks window.
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Recording Other Material with no Trackbreaks
If you had, say, a tape of an interview with The Dalai Lama, the procedure is much the same as recording one side of a single or 78.
Thus you would:
1. Check the This is a single box in the Record window
2. Add an album to your collection with artist Joe Bloggs (that's you) and title Interview with the Dalai Lama
3. Record the tape
4. Tidy up the recording in the Split Tracks window window if you so wish; truncating the recording to remove any silence at the end
will save you some disk space.
5. Burn the 'album' to CD (or save as an MP3 file)
For more information on how singles tracks are named when they are saved, please refer to where are my files located?

W hat file format should I use?
The recording format VinylStudio uses is set in the Recording Options dialog under the Options menu. We generally recommend
recording to an uncompressed format (WAV on Windows, WAV, AIFF or CAF on the Mac) as this provides the best audio fidelity and
makes VinylStudio run faster. You can also record to a lossless compressed format (FLAC or Apple Lossless) and cut your disk space
requirements by about 40% with no significant downside, especially on a fast machine.
If you are short of disk space however, you might like to record to a lossy compressed format, i.e. MP3, OGG or AAC. This uses much less
disk space - about 75MB per album rather than 500 - but there is a slight loss of sound quality. All VinylStudio functions are available on
all types of file, and there are also facilities to convert from one format to the other. To help you decide, you might like to make a couple
of test recordings and compare them on headphones.
If you plan to cleanup your recordings, the audio cleanup tools work slightly less well when recording to a lossy compressed format. Also,
if you edit such a file outside VinylStudio, you will need to transcode it which will cost you some quality.
Please note that the format you save your tracks in need not be (and usually isn't) the same as the format used to make your
recordings.

Splitting Tracks

In the Split Tracks window, you can:
Enter track listings
Split up your recordings into individual tracks
Getting around in the waveform display
Use the toolbar to perform various functions
Edit the album title, artist, release year and genre etc., and import Album art
Save your split-up tracks, one audio file per track
You can also edit an album title and/or artist, by selecting the album from the drop-down box, right-clicking on it and selecting Edit
Album Details.

Entering, Editing or Importing a T rack Listing
Please note: There is now a video tutorial about this on YouTube, see: https://www.youtube.com/watch?v=CJ5poE8eAac. Enjoy
It is worth doing this first as it makes splitting the recording into tracks much easier subsequently. You can do this while recording is in
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progress.
The first thing to try is VinylStudio's Lookup Track Listing feature. With luck, this will find a track listing which matches, or closely
matches, your album. Most of the online databases also include track times, in which case VinylStudio will create trackbreaks for you in
more or less the right places. If not, or if the retrieved listing is inaccurate, read on.

There are a number of tools in the Split Tracks window to edit an incorrect or incomplete listing, or to enter one from scratch:
To enter new tracks, click on the last entry in the list. This opens a new window where you can enter the track title, the duration
(if you have it) and the track artist (do this for compilation albums only). To enter further tracks, click Add Another.
To edit the details for an existing track, double-click on it (or click on it and press F2). Again, this opens a new window and if
you make a mistake in this window, close it and use Undo
(Ctrl+Z).
To move a track in the list, click on it and drag it to the desired position. To preserve your existing trackbreaks when moving or
deleting a track, hold down the Alt key while you are moving it.
To delete a track, click on it and press Del.
For more options, right-click on an item in the list.

New tracks are always added at the end of the list; you can drag them to the correct position in the list subsequently, if necessary. If
you have the track times to hand (on the LP sleeve, say, or on the disc itself), it is worth typing them in, especially for classical music,
as VinylStudio will then create trackbreaks for you in more or less the right places. You should avoid using the same name (e.g. Allegro)
for different tracks in the same album as this can cause problems with Windows Media Player, iTunes and other music players.
To import a track listing from a file, select Import Track Listing from the Track menu. Each line of the file should contain a track name
followed by an optional track time in brackets, e.g.:
Yellow Submarine (2:47)
For compilation albums, follow the track artist by a hyphen with a space on either side, e.g.:
Beatles - Yellow Submarine (2:47)
If a track name contains a hyphen, you can either omit the spaces round the hyphen or type it as two hyphens, e.g:
When I'm Sixty--Four
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When I'm Sixty--Four

Splitting Y our R ecordings into T racks
If you have entered (or been able to lookup) reasonably accurate track times as described above, you are already most of the way there
as VinylStudio will have inserted trackbreak markers for you and you will just need to position them accurately in the gaps between the
tracks as described below. If not, you can try your luck with VinylStudio's Scan for Trackbreaks feature. You will need to wait for
recording to complete first, of course, and results can vary depending on the nature of the music.
Whatever stage you are at in the track-splitting process, you can insert and / or adjust trackbreaks manually in the waveform display
using the controls in the toolbar beneath it. Here is an example, with a few trackbreaks already defined:

To insert a trackbreak, drag the cursor (click on the
) to the gap between the tracks and click on the Insert Trackbreak button
; you can also add a trackbreak by double-clicking anywhere in the waveform display. To split the current track when inserting a
trackbreak, press and hold the Alt key.
To adjust the position of a trackbreak, click on and drag the trackbreak marker in question. To position it precisely, zoom in using the
zoom buttons in the toolbar (see below), the scroll wheel on your mouse or the + and - keys. Move the cursor to the area of interest
first - VinylStudio centres this in the display when you zoom in.
To delete a trackbreak, click on the relevant marker and then click on the Delete Trackbreak button
either side of the trackbreak you are deleting, press and hold the Alt key.

. To merge the two tracks

To eliminate the gap between tracks, position the trackbreak at the end of the first track (zooming in as necessary) then click on and
drag the green start marker while holding down the shift key. VinylStudio (usually) automatically eliminates the dead air at the end of
the LP side (and marks it with a grey cross-hatch). If you wish to add a fixed period of silence between each track, see the Settings
dialog dialog.
To move trackbreaks as a group, hold down the Alt key while dragging. This is useful when you have retrieved a track listing from one
of the online databases and the tracks on side 2 are all a little out of kilter.
To move quickly from track to track while zoomed in, click on a track in the track listing.
To fade a track in or out, use the Adjust Faders dialog or hold down the Alt key and drag the little square boxes that then appear.

G etting around in the W aveform Display
It is well worth learning how the waveform display works (and the toolbar beneath it) to get the best out of VinylStudio.
To position the cursor (the vertical black line in the waveform display), click anywhere in the waveform display or click on the
and
drag it to where you want it to be. VinylStudio uses the cursor to center the dislay when you zoom in, and moves the cursor along the
display when the track is playing. While playing in anchor mode, clicking in the waveform display positions the anchor point (displayed as
a greyed-out cursor) rather than the cursor itself. To position the cursor, shift-click.
To zoom in an out, use the various zoom buttons in the toolbar listed above, the scroll wheel on your mouse or the + and - keys. Move
the cursor to the area of interest first - VinylStudio centres this in the display when you zoom in.
A number of functions are also available by right-clicking in the waveform display.

Using the T oolbar
The toolbar beneath the waveform display provides a number of tools to help you split your recordings into tracks quickly and efficiently.
Shortcut keys are shown in backets:
(space
bar)

Starts playing from the current cursor position. Click in the waveform display first to position the cursor if necessary.
Stops playing. In anchor mode, the cursor will return to the anchor point (which is displayed as a greyed-out cursor
while playing) unless you hold down the shift key. To switch between anchor mode and classic mode, use the 'cursor
options' button
.

(/)

Pauses / resumes playback. This button is only displayed in anchor mode.

<

Jump to the beginning of the selection (if there is one) or the recording. This is a shortcut key rather than a button.
Press it twice if necessary. While playing in anchor mode, hold down the shift key to move the anchor point rather
than the cursor.

>

Jump to the end of the selection (if there is one) or the recording.

(

Move backwards by one disc rotation period. Use this when manually repairing scratches that run across the disc. You
can change the rotation period for the current album in the Edit Album Details dialog.

)

Move forwards by one disc rotation period.
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(S)

Plays the current selection (shown highlighted in yellow in the waveform display). Shift-click to play in a continuous
loop. To define a selection, click and drag in the waveform display. To clear the current selection, press Esc.

(1)

Plays a brief snatch of music spanning 1 second either side of the current cursor position.

(5)

Play track breaks - plays the first and last 5 seconds of each track, starting from the current cursor position. The
amount of audio playes can be changed in the Settings dialog.
Displays a dropdown offering a choice of various cursor options, including whether the display pans to follow the cursor
when it moves off the right-hand edge of the screen while playing. Use the dropdown to switch between anchor mode
and classic mode.
Stop playing at the next end-of-track marker.

(+)

Zoom in, centering the display at the current cursor position. Click in the waveform display first to position the cursor
to the area of interest if necessary. You can also zoom in and out with the scroll wheel.

(-)

Zoom out. You can also zoom in and out with the scroll wheel.

(Z)

Zoom in (or out) so that the current selection exactly fills the window.

(A)

Zoom all the way out (so that the entire recording is visible).

(M)

Insert a marker at the current cursor position. This lets you mark a particular spot that you might to come back to
later. To delete a marker, click on it and press D.

(B or
double click)
(Del)

Insert a trackbreak at the current cursor position. You can do this while the recording is playing if you wish, which can
be handy for live albums. You can also insert a trackbreak by double-clicking anywhere in the waveform display. To
split the current track when inserting a trackbreak, press and hold the Alt key.
Delete the trackbreak under the cursor. Click on the trackbreak you want to delete first. To merge the two tracks
either side of the trackbreak you are deleting, press and hold the Alt key.
Displays instructions on how to eliminate the gap between tracks.

(T)

Zoom in (or out) such that the current track exactly fills the window. This also opens the track details dialog, which
allows you (amongst other things) to fade the track in or out.

(F)

Adjust the faders for the trackbreak under the cursor. This lets you set up a 'cross-fade' between one track and the
next. Click on a trackbreak first. You can also adjust faders by holding down the Alt key and dragging the little square
boxes that then appear.
Scan for the end of the current track.
Opens the scan settings dialog. Scanning for trackbreaks is not an exact science, so some adjustment of these
settings may be needed to get the best results.

(C)

Determines whether you hear corrected or uncorrected (i.e. the original, as recorded) audio when you click Play.
Corrections, such as scanning for clicks and removing tape hiss, are applied in the Cleanup Audio window.
Turns off audio in the left or right-hand channel (so that you can listen to just one).
Opens the Windows mixer applet, which allows you to adjust the playback volume. You can also change the current
playback device by clicking on thew down-arrow.

J

Jump back one second. Shift+J jumps back 10 seconds.

N

Jump to the start of the next track.

P

Jump to the start of the previous track.

` (back quote) Switch to the Cleanup Audio window (toggle).
5

Remember the current zoom level and cursor position.

6

Return to the zoom level and cursor position saved above.

9 or ( / 0 or )

Go forwards or backwards one rotation of the record, spproxinmately. Usefui for repairing long scratches manually.

In addition, you can use the arrow keys as follows:
Left / right arrow: scroll the waveform display left and right.
Shift-left / right arrow: move the cursor left and right in small increments.
Ctrl-Shift-left / right arrow: move the cursor left and right in larger increments.
TIP: it's worth learning the shortcut keys for the functions you use most; it can save a lot of time if you have a lot of albums to process.
The shortcut key for a particular toolbar button is also displayed when you hover over it with the mouse.

Editing album details and importing album art
You can edit the various bits of information that VinylStudio stores for an current album by clicking on the Edit Album Details button
(or by selecting Edit Album Details from the Album menu):
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You can enter whatever information you have to hand in this dialog. Any information you enter will be stored (as tags) in the files you
generate when you save your tracks. For more information on recording singles, click here.
Information on what the This is a single checkbox does, can be found here.
Mix down to mono specifies that the tracks for this album will be saved in mono rather than stereo. Some people prefer this for mono
material and it can save some disk space, especially when saving in uncompressed formats.
Album art can be imported from files on your hard disk or looked up over the internet. You can also drag and drop images from most web
browsers or from Explorer, or you can use Copy and Paste.
To import from an existing file, click Browse and navigate to the file on your hard disk. VinylStudio will embed the image in any files it
generates for this album when saving tracks and it will scale it down if necessary to keep the resulting files down to a reasonable size.
You can control VinylStudio's exact behaviour in this regard in the Settings dialog.

Not all web browsers support drag and drop for images. We have tested the following:
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Firefox
Google Chrome
Internet Explorer
Opera
Safari

Supported.
Supported.
Supported for certain images only (specifically, those that do not link to another page or image).
Not supported, but some images can be dragged to your desktop and then from there into VinylStudio.
Supported.

Where a browser does not support drag and drop, right-click on the image to save it as a file and then navigate to that file via the
'Browse' button in VinylStudio's Edit Album dialog, or use Copy and Paste.

Saving your T racks
Once you have positioned all your track breaks and entered all the track details (a lot of which is automated if you can find your album in
one of the online databases that VinylStudio supports) then you can save your tracks.
To do this, click on the Save Tracks button, select the file type you want to save to and any relevant options (such as the level of
compression for MP3 files, for example) and then kick the process off. VinylStudio will then save your tracks and log the results. If all is
well then the resulting files whould be ready for use. If not, the log will tell you what went wrong and you can correct it and try again.
VinylStudio Pro can also save tracks for several albums at a time. You do this in the Batch window.

Lookup T rack Listings and Album Art
VinylStudio can look up track listings for many LPs over the Internet. To do this, click on the Split Tracks tab, select the album from the
dropdown list if necessary and then click Lookup Track Listing. This will popup the following window:

With luck, you will be able to retrieve a full track listing from one or other of the available databases by clicking Lookup. If so, select the
best match and then click Use Selected Listing.
If you can't find a match, try simplifying the artist or album title - just a few keywords will often do. Alternatively, you can try a different
database. Music Brainz seems to have the best balance between coverage and 'noise', but the other databases are worth a try for more
obscure material.
For Discogs, you can also enter the catalog number (without spaces or punctuation) in the Album Artist field, preceded by a #, e.g.
#74321589412. Leave the album title blank. You can broaden your search by starting the album artist with a + sign, e.g. +Billy Joel. This
can be useful if a search returns no hits. You can also search by Discogs release ID this way, or by enclosing it in square brackets, e.g.
[r499497].
Because some entries are for CDs rather than vinyl albums, track listings are sometimes in the wrong order or may contain extra tracks.
You can edit an incorrect or incomplete listing as follows:
to edit a track name, click on it and press F2; you can also edit the track time in this way
to move a track in the list, click on it and drag it to the correct position in the list
to delete a track, click on it and press Del
to add tracks, type them in at the end of the list; you can then drag them to the correct position in the list if necessary
for more options, right-click in the list
You can also edit the track listing subsequently in the Split Tracks window. Doing it there has the advantage that you can Undo
(Ctrl+Z) and Redo
(Ctrl+Y) any changes you make. If the retrieved listing does not contain track times (or if they are inaccurate), it
is worth typing them in if you have them to hand, especially for classical music. VinylStudio will then position trackbreak markers for you
-- 20 --

in roughly the right places.
Lookup Album Art
VinylStudio can download album art from the Discogs and Music Brainz databases. This is then embedded in the files generated when
VinylStudio saves your tracks (but not for WAV files).
To retrieve album art from one of the online databases, lookup the album in the same way as described above. Then click Fetch Album
Art to see the cover as a thumbnail, at which point the button changes to Import Album Art. Click this in turn to download the album
cover and store it as a file in your recordings folder. Note that you can download album art from one looked-up album and use the track
listing from another, even if they come from a different databases. Coverage in Music Brainz is currently rather patchy.
You can also import album art from a file on your hard disk. To do this, select Edit Album Details from the Album menu and click on the
'Album Art' tab. You can also drag album art from most browsers to this tab, or use Copy and Paste.
Some other sites you might try for downloading album art are:
www.albumart.org
images.google.com
If you use these sites, you will have to save the image to your hard disk and then import it into VinylStudio in the Edit Album Details
dialog (or drag the image across from your browser).

Scan for T rackbreaks
Once you have recorded an album (both sides!), you can scan it for trackbreaks. This can be useful when Lookup Track Listing has failed
to find a match or when no track times are available. It is not, however, a precise science and results can vary. You can always, of
course, add trackbreaks manually, and it is well worth learning how to do so.
Scanning for Gaps Between Tracks Automatically
To scan for trackbreaks automatically, go to the Split Tracks window (if necessary) and click on Scan for Trackbreaks. This attempts
to find all of the trackbreaks in your recording in one go:

Results can vary, depending on the material being scanned, and you can adjust the trackbreaks detected by Scan in the Split Tracks
window. If you don't like what Scan did, use Undo
(Ctrl+Z) and try adjusting the scan settings, or try the semi-manual procedure
described in the following section.
Scanning for Gaps Between Tracks Manually
To scan for trackbreaks manually, click to the right of the rightmost trackbreak (if any) and then click on the Scan button
in the
toolbar beneath the waveform display. Scan will then insert a red end-of-track marker at the next gap in the music (so keep your eyes
on the waveform display as you do this).
If Scan does not go far enough, just click on the Scan button again. If it goes too far, you can use Undo
the Scan Settings as shown above, or just drag the trackbreak to where you think it should be.

(Ctrl+Z) and then adjust

Once the trackbreak is where you want it, click in in the right-hand part of the waveform display. Then click on the Scan button
again to insert the next trackbreak, and so on until all trackbreaks have been inserted.

Zoom T rack Dialog
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This dialog is displayed when you click on the Zoom Track button, and it allows you to focus on the current track. You can continue to
work in the waveform display while this dialog is open but the trackbreak markers for the other tracks are disabled. You can fade the
track in and out by clicking the appropriate checkbox, and you can adjust the start and end time of the track precisely in the dialog
itself.
Use the >> and << buttons to jump to the next or previous track respectively.
To start playing from one of the markers, click on (but do not drag) the marker. To jump to any position in the track (even when the
track is playing), click anywhere in the waveform display.

Adjust Faders Dialog

This dialog is displayed when you click on the Adjust Faders button (you will need to click on a trackbreak first) and allows you to focus
on a single trackbreak to fade the tracks in and out (or, rather, out and in). You can continue to work in the waveform display while this
dialog is open, but all other trackbreak markers are disabled.
The currently selected track is shown highlighted in blue, and parts of the waveform which have been faded out (which will include all
preceding and subsequent tracks) are shown greyed-outand will not play until you select them (which you can do by clicking on them
after closing this dialog).

Once you have turned on fade-in or fade-out for a particular track, you can adjust the fade-in or fade-out points by dragging the
markers in the waveform display; the Adjust Faders dialog does not need to be open to do this. To start playing from a marker, click on
(but do not drag) the marker. To jump to any position in the track (even when the track is playing), click anywhere in the waveform
display.
The >> and << buttons provide a convenient way to jump to the next or previous trackbreak respectively. This will only work if you
have first defined trackbreaks in the Split Tracksb> window.
If you hear faint clicks with the faders enabled, enable the rumble filter in the Filter Settings dialog.

Cleanup Audio

-- 22 --

The Cleanup Audio window lets you remove clicks, scratches, tape hiss from your recordings and more. You don't need to save working
copies of your files as you edit them - VinylStudio keeps track of your changes and applies them as and when needed (to any CD's you
burn or tracks you save) whilst keeping your original recordings intact. This can save a lot of disk space, and, coupled with extensive
Undo
and Redo
facilities, makes VinylStudio a productive and forgiving working environment. VinylStudio's audio cleanup features
are not just a toy; used correctly, they can achieve excellent results, even on badly damaged recordings.
In the Cleanup Audio window, you can:
Remove clicks, pops and scratches from your recordings.
Filter out hiss, hum and rumble.
Equalise your recordings.
Remove unwanted sections of audio ('cut and splice').
Patch bad scratches and dropouts.
Repair severe clicks and scratches manually (VinylStudio Pro only).
Hear the results as you work.
Switch to Spectral View (VinylStudio Pro only).
Display a Frequency Analysis of your recording (VinylStudio Pro only).
Use the toolbar to get around in the waveform display.
Follow any of the links above for more information.
The Cleanup Audio window also offers a number of 'housekeeping' tools, which let you:
Convert your recordings between MP3 and WAV formats.
Save working copies of your cleaned up files for editing outside VinylStudio.
Import files recorded or edited outside VinylStudio.
Delete unwanted files.
Again, follow any of these links for details.
Please note that if you have VinylStudio Lite, the audio cleanup features can only be used on a trial basis. Specifically, you cannot burn
cleaned up audio to CD or to saved tracks. To upgrade, select 'Upgrade to Full Version' from the Help menu.

For New Users
There are a lot of things you can do in the Cleanup Audio window and it's easy to get lost at first, so for new users, we recommend that
you proceed as follows:
first split your recording into tracks, if you have not done so already; this helps you find your way around your recording later on
then, if it is a vinyl (or shellac) recording, or a tape made from one, scan it for clicks
if it is a tape recording, or a noisy 78, apply the hiss filter; if not, you probably don't need to bother
finally, use the graphic equaliser if you feel you need to adjust the tone, especially for recordings made from cassette tape
repeat for side 2, if recorded separately
It is also worth spending a few minutes familiarising yourself with the operation of the waveform display and associated toolbar as
described in the sections below.
As you become more proficient, it is worth exploring the available filter settings in more depth as there is a lot you can do with them. In
particular, the rumble filter should be applied to all vinyl recordings and the hum filter can make a big difference in certain cases.

W aveform Display
Unlike the Split Tracks window, which works on the album as a whole, the Cleanup Audio window works on one album side at a time. The
display shows the audio signal both before and after any click repairs have been applied (one signal is superimposed on the other). The
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original signal is shown in green and repaired clicks are shown in grey:

Most of VinylStudio's functions work with the current selection. To define a selection (which is shown shown in yellow), click and drag in
the waveform display. You can subsequently adjust the either edge of the selection by clicking on it and dragging. To clear the selection,
press Esc.
Positioning the cursor and zooming in and out work in the same way as in the Split Tracks window but it is worth repeating that, when
you zoom in, VinylStudio uses the uses the current cursor position to centre the display (so you should position the cursor near the area
of interest before you zoom in). The waveform display is more fine-grained than the one in the Split Tracks window, and you can zoom
right in to see the individual samples if you wish.
A number of functions are also available by right-clicking in the waveform display.

Spectral View
(VinylStudio Pro only).
Spectral View shows the way that the frequencies are distributed in the audio stream. It can be useful for locating hard-to-find clicks
which tend to show up as spikes in the display when zoomed in enough. To best see such clicks, adjust the viewing window to span
about 5 seconds of audio. Note that corrected clicks are hidden in the spectral view when corrected audio is being displayed (press C to
toggle).

The colours in the display represent signal power at the frequency given by the Y coordinate. The colours are:
Grey

Minimum

Blue

Low

Red

Medium

White

High

You can adjust spectral view options (FFT size and maximum frequency displayed) via the Options menu. To switch between Spectral
View and the regular waveform display, press V or use the Cleanup Audio or right-click menu.
You need a reasonably fast PC to use spectral view effectively. The display speeds up as you zoom in. Switch back to the normal
waveform display (V) when zooming out for better performance.

Frequency Analysis
(VinylStudio Pro only).
VinylStudio can display a frequency analysis of part or all of your recording which can help you decide how to build an FFT filter to filter
out unwanted noise:
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Select 'Perform Frequency Analysis' from the Cleanup Audio window to display the Frequency Analysis window. selecting the section of
audio you are interested in first. Read off unwanted peaks in the display by moving the cursor over them and use this information to
construct an FFT filter in the Equalisation curves window.

Using the T oolbar
The buttons in the toolbar have the following functions (shortcut keys are shown in backets):
(space
bar)

Starts playing from the current cursor position. Click in the waveform display first to position the cursor if necessary.
Stops playing. In anchor mode, the cursor will return to the anchor point (which is displayed as a greyed-out cursor
while playing) unless you hold down the shift key. To switch between anchor mode and classic mode, use the 'cursor
options' button
.

(/)

Pauses / resumes playback. This button is only displayed in anchor mode.

<

Jump to the beginning of the selection (if there is one) or the recording. This is a shortcut key rather than a button.
Press it twice if necessary. While playing in anchor mode, hold down the shift key to move the anchor point rather
than the cursor.

>

Jump to the end of the selection (if there is one) or the recording.

)

Move forwards by one disc rotation period.

(

Move backwards by one disc rotation period. Use this when manually repairing scratches that run across the disc. You
can change the rotation period for the current album in the Edit Album Details dialog.

]

Move the cursor to the next yellow marker.

[

Move the cursor to the previous yellow marker.

}

Move the cursor to the next click.

{

Move the cursor to the previous click.
(S)

Plays the current selection (shown highlighted in yellow in the waveform display). Shift-click to play in a continuous
loop. To define a selection, click and drag in the waveform display.

(1)

Plays a brief snatch of music spanning 1 second either side of the current cursor position.
Displays a dropdown offering a choice of various cursor options, including whether the display pans to follow the cursor
when it moves off the right-hand edge of the screen while playing. Use the dropdown to switch between anchor mode
and classic mode.
Stop playing at the next end-of-track marker.

(+)

Zoom in, centering the display at the current cursor position. Click in the waveform display first to position the cursor
to the area of interest if necessary. You can also zoom in and out with the scroll wheel.

(-)

Zoom out. You can also zoom in and out with the scroll wheel.

(Z)

Zoom in (or out) so that the current selection exactly fills the window.

(A)

Zoom all the way out (so that the entire recording is visible).

(M)

Insert a marker at the current cursor position. This lets you mark a particular spot that you might to come back to
later. To delete a marker, click on it and press D. Markers also appear in the corrections list, and you can select a
marker by clicking on it in the list.
Show / hide trackbreaks (toggle).
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(N)

Scan the recording (or current selection, if any) for clicks. To define a selection (highlighted in yellow), click and drag
in the waveform display.

(R)

Insert a click repair at the cursor position manually. Use this if VinylStudio has failed to find the click by scanning. To
adjust the width of a repair, zoom in on it and drag either edge. To select a click repair, click on it in the corrections
list list.

(P)

Patch the current selection. Use this to repair damaged areas, such as scratches or dropouts, which are too wide for
VinylStudio's click repair capabilities. To select a patch, click on it in the corrections list list.

(X)

Cut out the current selection, and cross fade the edges of the cut with the surrounding audio. To select a cut, click
on it in the corrections list list.

(F)

Opens the filter settings dialog, which allows you to filter out tape hiss, hum and rumble, and includes a graphic
equaliser.

(E)

Opens the Equalisation curves (FFT filters) dialog, which allows you to apply precise equalisation or filtering, including
RIAA and other recording equalisation curves.

(C)

Determines whether you hear corrected or uncorrected (i.e. the original, as recorded) audio when you click Play.
Corrections, such as scanning for clicks and removing tape hiss, are applied in the Cleanup Audio window.
Turns off audio in the left or right-hand channel (so that you can listen to just one).
Opens the Windows mixer applet, which allows you to adjust the playback volume.

` (back quote) Switch to the Split Tracks window (toggle).
J

Jump back one second. Shift+J jumps back 10 seconds.

V

Switch to and from Spectral View (toggle).

5

Remember the current zoom level and cursor position.

6

Return to the zoom level and cursor position saved above.

9 or ( / 0 or )

Go forwards or backwards one rotation of the record, approxinmately. Useful for repairing long scratches manually.

In addition, you can use the arrow keys as follows:
Left / right arrow: scroll the waveform display left and right.
Shift-left / right arrow: move the cursor left and right in small increments.
Ctrl-Shift-left / right arrow: move the cursor left and right in larger increments.

C leanup Audio - Scan for C licks
VinylStudio is capable of finding and fixing most of the clicks and scratches in your vinyl recordings automatically. That said, click repair is
not an exact science, and some form of manual intervention is sometimes needed to get the best results, especially if your recordings
have a lot of heavy clicks or, in particular, scratches. It is important to listen to the results, and using headphones helps a lot.
To scan your recording for clicks, click on the Cleanup Audio tab if necessary and then click on the Scan for Clicks button
lower toolbar. This displays the following dialog:

in the

You can either scan the entire file, or make a selection first (by clicking and dragging in the waveform display) and then scan (or rescan) just that.
There are four main settings which affect the operation of the click detector (you will be prompted for these each time you initiate a
scan):
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Sensitivity (levels 1-5 + 'turbo', default=3)
Percussion protection (PP, levels 1-5, default=2)
Brass protection (BP, on or off, default=on)
Number of passes (1-4, default=1); one pass is usually adequate
The "Default settings" preset is recommended for first-time users or for material which you have not scanned before, and represents a
good compromise between finding as many clicks as possible and preserving the quality of the original audio. Use the 'turbo' settings (6
and 7) with care as these can cause distortion and take longer to complete the scan. They are intended for use on difficult material with
a large high-frequency content, such as modern jazz.
For more information on how and when to adjust VinylStudio's click repair settings, refer to the Tips for Removing Clicks page.
Depending on its condition, scanning an LP side takes around 1 minute on a reasonably fast computer; less on modern hardware. Once
the scan is complete, you can listen to the results and compare them with the original, uncorrected version by clicking on the
button
in the toolbar. All changes are non-destructive - they are stored in a separate file and your original recording is not changed - and you
can undo the scan (Ctrl+Z) if you don't like the results.
When scanning fails to find a click or impairs the quality of the music, you can rescan the offending area with different settings, or, if
necessary, repair the click manually. For more information on how to get the best out of your vinyl, refer to the Tips for Removing Clicks
page.
Note: if (and only if) you recorded with a 'flat' phono preamp, or if you applied only inverse RIAA equalisation at record time, you should
check the 'Recording needs equalisation' box. This will greatly improve the accuracy of VinylStudio's click scanner. Do not check this box
if you are recording an old 'acoustic' disc (i.e. one which requires no equalisation in the first place). In that case, just apply inverse RIAA
at record time if you cannot defeat the RIAA equalisation built into your phono preamp and scan for clicks using the default settings.

C leanup Audio - Filters
VinylStudio has a complete set of filters to help you cleanup your recordings and to adjust the tonal balance. You can filter out hum, hiss
(and other forms of noise) and rumble, and there is also a graphic equaliser with a normalisation facility. Filtering can be applied to an
entire LP side, to individual tracks or even specific sections of music within a track.
You will hear the effects of your filters immediately while working in VinylStudio, but no changes are made to your original recordings.
Instead, VinylStudio applies filtering 'on the fly' as and when needed - i.e. when you save your tracks, when you burn a CD or DVD, or
when you save a copy of your original recording with corrections enabled.
Please note that the effect of any filters being applied is not shown in the waveform display. If you want to see what your audio looks
like after filtering, you can save a copy of your recording from the File History List.
To apply or adjust the filters for the currently selected album side, click on the Filters button
in the lower toolbar. This displays the
Filter Settings dialog shown below. All of the controls in the main window remain active while this dialog is open.
Hum Filter
Filtering is normally applied to an entire album side at a time, so we will cover that first. To adjust the Hum filter, click on the Hum Filter
tab:

For the hum filter, the only thing you need to specify, other than whether to turn it on or not, is the mains frequency in your houeshold
(or, to be precise, the mains frequency in the household where the recording was made); this is 50Hz in the UK, Europe, Australia and
China, and 60Hz in the Americas (in Japan it varies by region). Recordings made from vinyl often contain a certain amount of hum, so if
yours are affected in this way try turning this on while listening to a quiet passage on headphones. If hum filtering seems to inefeective,
try changing the mains frequency.
Hiss Filter
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The hiss filter is useful both for tapes and for other recordings with a high level of background noise such as 78's or badly worn vinyl
recordings. We do not recommend applying it to vinyl recordings in good condition however as it is a subtractive process and can
introduce a certain amount of distortion. But feel free to experiment - you can always turn it off again.
For the hiss filter to function properly, VinylStudio needs you to define a Noise sample - a short section of the recording (1 second or
so) containing background noise (NOT complete silence) and nothing else. You will be prompted to do this the first time you turn the hiss
filter on, and you do so by selecting a suitable section (by clicking and dragging in the waveform display). If you get this wrong, the
results can either (a) sound very strange or (b) not be filtered at all so if you think this has happened to you, click on Redefine Noise
Sample and try again.
You can also load a noise sample from a previously saved file. This is useful if you have a recording where there is no place to define a
noise sample in the normal way. Use this feature with care - inaccurate noise samples give poor results. You can also view a spectral
analysis of the currently defined noise sample via Show Noise Sample.
The two sliders determine how much filtering is applied; we suggest you experiment with these while listening to a quiet passage on
headphones. Don't be tempted to remove every last trace of hiss as this can make things sound rather artifical.
Hiss filtering works best after you have declicked your recording.
Rumble Filter

The rumble filter is a simple on / off affair. Turn it on to filter out potentially damaging low frequency noise often present on vinyl
recordings (especially in the leadin) or introduced by turntable bearings. High levels of rumble can sometimes cause a faint click at the
beginning and end of tracks and can also cause the hiss filter to introduce faint clicking sounds into the music. Turning the rumble filter
on will eliminate this. The rumble filter also performs DC-offset correction.
Graphic Equaliser

Use the graphic equaliser to, for example, boost the treble on recordings made from cassette tapes which can often sound rather dull.
Changes are applied in real time so you can adjust the sound until you get the results you want. The preamp setting can be used to
boost quiet signals, but be careful not to set this too high - if the VU meters turn completely red while playing a loud section you need to
turn this down.
Normalisation
To normalise a recording, click Normalise. This displays a dialog to let you choose the desired final volume level and other options:
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Like all the audio cleanup tools, VinylStudio's normalisation procedure is non-destructive - i.e. no changes are made to the recorded file.
Instead, the results are applied when you burn CDs or save your tracks. You can also normalise albums in 'batch' mode in the Batch
window. Please note that, like all the filters, the results are not shown in the waveform display. The effects of any filters in effect are
included in VinylStudio's calculations when you run the normalisation procedure however, so do this last.
If you wish to normalise all recorded sides for the album in a single operation, check Normalise all album sides before normalising.
VinylStudio can then either normalise each side separately (the default), or adjust all sides by the same amount (which will be governed
by the loudest album side). You can also elect to normalise each track separately.
If you have VinylStudio Pro, you can turn on VinylStudio's 'smart normalisation' feature. This ignores audio in the gaps between tracks
(as well as before the start of the first track and after the end of the last) and, in particular, can be used to prevent the sound of the
needle drop and lift from affecting the results.
For this to work properly, you need to position the track break markers correctly before you perform the normalisation step. Specifically,
make sure that you position the first green start-of-track marker past the initial needle drop, and the last red end-of-track marker before
the final needle lift. You also need to elide the needle lift and subsequent drop between album sides, again by postioning the track break
markers on either side appropriately. You can do this by ensuring that the red marker is positioned before the needle lift and then
dragging the following green marker past the needle drop, like so:

Playing the audio as you work will help you get this right.
Presets
You can save frequently used filter settings as a preset. To do this, adjust the filter settings as desired and then click Save. Presets
are named and a few predefined ones (marked with an asterisk) are provided for the more common situations you might encounter. The
'78 recorded at 45RPM' preset attempts to correct inaccuracies in equalisation caused by recording at the wrong speed, but vintage
records use varying equalisation schemes anyway so trust your ears and be prepared to experiment.
To apply the same settings as you used previously, select Last settings used.
Filtering Individual Tracks (or any other section of music)
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VinylStudio can apply any set of filters to any section of music within an LP side. You might want to boost the bass on a particular track,
for example. To do something like this, click on Advanced options and then on the Add Filter button to add a new set of filters. This
displays the following dialog:

While this dialog is open, you can either define a selection by clicking and dragging in the waveform display or you can select a track
from the list and click Select Track. Either way, the new set of filters will be applied to the range you specify.
After you close the Add Filter dialog, the Filter Settings dialog should look something like this:

You will notice that a second entry has appeared in the list (#2) showing the section of music to which this set of filters is to be applied.
Adding a new set of filters in this way allows any filter (hum, hiss, rumble and equaliser) to be adjusted in whatever way you choose for
the section of music specified.
You can add as many sets of filters as you like in this way and for each type of filter you can say whether you want to turn it on, turn it
off, or keep the existing settings (i.e. 'unchanged from the above'). This provides a lot of flexibility - more than you need probably - but
it does let you say things like 'boost the treble on the entire recording except for tracks X, Y and Z'.
Note that filters don't 'add up' - that is to say, for example, adding a second hiss filter does not perform double the amount of filtering.
Where the ranges of two or more filters overlap, the last one in the list takes precedence.

C leanup Audio - Equalisation C urves (FFT Filters)
(VinylStudio Pro only).
Starting with version 8.5, VinylStudio can apply FFT (Fourier transform)-based equalisation curves / filters to your recordings. All filters
are applied in real time - What you Hear is What you Get - and no changes are made to your original recordings. Instead, VinylStudio
applies filtering 'on the fly' as and when needed (when burning a CD, for example). Filtering can be applied to an entire LP side, to
individual tracks or even specific sections of music within a track. You can also apply more than one Equalisation Curve / Filter at a time.
An implementation detail that might be of interest is that FFT-based filtering and hiss filtering are carried out by the same piece of code,
thus halving CPU-time requirements (and FFT-induced artefacts) when both features are enabled at the same time. It also doesn't
matter how many curves you define. VinylStudio does them all together and applies them just once.
To apply or adjust equalisation curves / filters for the currently selected album side, click on the Equalisation curves button
in the
lower toolbar. This displays the dialog shown below (note that all of the controls in the main window remain active while this dialog is
open).
Please note that the effect of any filters being applied is not shown in the waveform display. If you want to see what your audio looks
like after filtering, you can save a copy of your recording from the File History List.
Applying a Single Filter
To apply just one filter, click on the 'On' button or select a preset: from the dropdown list:

-- 30 --

To edit the curve, click and drag any 'node' (circle), click outside any node to insert a new one, or drag a node out of the window to
delete it. If you make a mistake, use Undo (Ctrl+Z) or Redo Ctrl+Y). See also under the 'More' button for additional options.
You can constrain dragging to the vertical axis by holding down the Shift key, or to the horizontal axis by holding down the Control key.
You can save your work as a preset at any time by clicking 'Save Preset', but VinylStudio will apply your changes to the current
recording (and remember what they are) whether you do that or not.
Applying More than One Filter at a Time
VinylStudio can apply several filters to the same recording, the result being the cumulative effect of all the filters specified. To do this,
click on Advanced options and then on the Add Filter button to add a new filter. This displays the following dialog:

Unless you only want to apply filtering to (say) a particular track, click 'Apply to Entire Recording'. The result should look something like
this:

You will notice that a second entry has appeared in the list (#2), representing the newly added filter. You can then edit the curve or
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select a preset as above and the result will be added to the first filter you defined (unless you turn it off in which case it has no effect
at all). There is no limit to the number of filters you can add in this way, although it is uncommon to define more than a couple.
Filtering Individual Tracks (or any other section of music)
VinylStudio can apply a filter to any section of music within an LP side. You might want to boost the bass on a particular track, for
example. To do something like this, click on Advanced options and then on the Add Filter button to add a new set of filters. This
displays the same dialog as previously, but you use it differently:

While this dialog is open, you can either define a selection by clicking and dragging in the waveform display or you can select a track
from the list and click Select Track. Either way, the new filter will be applied to the range you specify.
After you close the Add Filter dialog, the screen should look something like this:

This time, the newly added entry (#3) only applies to the section of music you selected and there are more radio buttons to choose
from. These buttons allow precise control over how the filter is applied as follows:
Override: the newly added filter replaces any filters above it in the list for the section of music in question (i.e. preceding filters
are ignored).
Off: all filtering is turned off for the section of music in question.
No change: the newly added filter has no effect at all.
Append: the newly added filter is added to any previous filters defined (i.e. their effect is cumulative).
You can add as many filters as you like in this way and for each one you can say whether you want to turn it on, turn everything off,
keep the existing settings (i.e. 'unchanged from the above') or add to the existing filters. This provides a lot of flexibility - more than you
need probably - but it does let you say things like 'boost the treble on the entire recording except for tracks X, Y and Z'.
Applying Recording Equalisation
If your phono preamp has a 'flat' switch, if you are recording discs cut before 1954, or if you recorded with speed conversion enabled,
you can apply recording equalisation to correct the tonal balance of your recording. If you simply want to apply RIAA equalisation, use
the RIAA preset. For anything more complex, select 'Apply Recording Equalisation' under the 'More' button, which will display the following
dialog:
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For discs cut from 1954 onwards, the RIAA preset should generally be used. For earlier discs, VinylStudio comes with a large number of
preset curves but selecting the right one can be a challenge. Try consulting the sleeve notes or plug in a decent set of headphones and
adjust the parameters by ear. Increasing the bass turnover frequency will boost bass notes. Increasing the 10kHz rolloff value will cut
treble. You can save your settings as a preset, and you can also enter time constant values if that is the information you have. Either
way VinylStudio will remember your settings and apply the correct curve to the recording.
When using recording equalisation, use the 'flat' switch on your phono preamp if it has one. If it doesn't, check the 'Apply inverse RIAA
first' box. If you recorded with speed conversion enabled, it is important to tell VinylStudio so that it calculates the correct inverse
curve. VinylStudio will generally remember this for you but older versions of VinylStudio didn't so you will need to set it here.
If you are recording via a Graham Slee Accession preamp set to CA/FLAT, the procedure is slightly different. If you are recording a disc
that uses standard RIAA equalisation, just select 'Inverse Accession CA/FLAT' from the dropdown. If, on the other hand, you are
recording an older disc that requires a different equalisation curve, select that from the dropdown instead and check the 'Apply Inverse
Accession CA/FLAT and Inverse RIAA first' box.
Once you quit this dialog, VinylStudio will add, possibly composite, curve to your recording, and it is this that does the actual work:

Please note that you can also apply recording equalisation at record time, which can improve the dynamic range of your recordings if
recording at 16 bits per sample and also has the advantage that the waveform display shows the correctly equalised signal. This is our
recommendation.
The equalisation curves built into VinylStudio were taken from the Audacity wiki,
http://wiki.audacityteam.org/wiki/78rpm_playback_curves and references therein, with much thanks. You can also enter the parameters
yourself for certain curves by looking them up at Vinyl Engine: www.vinylengine.com/cartridge_database_record_equalization.php.
The Inverse Accession CA/FLAT curve is supplied courtesy of Graham Slee, see:
www.alpinesoft.co.uk/VinylStudio/accession_ca_flat.aspx.
Importing and Exporting Audacity Equalisation Curves
You can import and export curves from / to a file that Audacity 2.x can understand by selecting Import / Export Audacity Curves from
the menu under the More button. This can also be used to move equalisation curves / filters between machines (including Macs and
PCs).

C leanup Audio - C ut and Splice
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To cut out an unwanted section of audio, select it (by clicking and dragging) and then click on the Cut and Splice button
in the
toolbar beneath the waveform display in the Cleanup Audio window. If you don't like what you hear, select Undo
(Ctrl+Z), adjust the
edges of the selection and try again.
VinylStudio cross-fades the sound on either side of the cut to make the cut less obvious. Select your desired splice length before you
make your cut. Use 'splice length short' if, as is common, you are cutting out very short sections such as bad scratches.
Cuts are shown in the waveform display as a vertical blue dotted line which, as you zoom in, becomes a cross-hatch showing the crossfaded area:

To delete a cut, right-click on it in the corrections list and then select Delete Cut. You can also delete a cut by selecting it in the list
and pressing Del. If you zoom in sufficiently, you can also select a cut by clicking on it in the waveform display.
Please note that you don't need to use cut-and-splice to eliminate gaps between tracks. And nor should you - just shift-click on the
green start-of-track marker in the Split Tracks window and drag it to the right. But if you do want to cut out a section of audio while you
are in the Split Tracks window, proceed as follows:
1. Select the section of audio you want to cut out.
2. Click on the Cleanup Audio tab.
3. Click on the cut-and-splice button
in the toolbar beneath the waveform display.
4. Listen to your results.
5. Return to the Split Tracks window.
The key to this is that VinylStudio preserves your selection and cursor position when switching between windows.
Truncating Overly Long Recordings
If your recording has a long period of silence at the end, as many do, you can save some disk space by truncating it. To do this,
right-click on the waveform display at the appropriate point and then select Truncate Recording at Cursor. Please note that this
operation cannot be undone.

C leanup Audio - T he C orrections List
The Corrections List lists all the clicks, and potential clicks, found by scanning the album side. It also lists any
cuts you may have made, any markers you have inserted, any click repairs inserted or adjusted manually and
any patches you may have made.
Each entry in the list has a time stamp and then, for clicks or would-be clicks, the click width (in samples at
44100 samples per second) and the channel (Left or Right). In addition:
Click repairs are coloured cyan.
Potential clicks which have been identified as probable percussion bursts (and hence ignored) are marked
PP, and coloured purple.
Potential clicks which have been identified as probable horn blasts and the like are marked BP, and
coloured blue (not shown in this example).
Clicks inserted or adjusted manually are marked Manual, and shown in light cyan.
Patches are shown in green (not shown in this example)
Click repairs wider than 50 samples can be a cause for concern and are coloured red.
Cuts are also coloured blue.
Markers inserted by the user are coloured dark yellow.
Corrections falling within the current selection are shown with a pale yellow background.
The current cursor position in the waveform display is shown by this symbol:
The checkboxes below the list control what is displayed. Note that, to select a click repair in the waveform
display, Show Clicks must be checked.
To select a correction from the list, click on it and then zoom in using the mouse wheel, the + and - keys or the zoom buttons in the
toolbar. You can also use the corrections list to delete a correction - right-click in the list for more information.
TIP: to select a range of corrections, click on the first in the list and then shift-click on the last.

C leanup Audio - T ips for R emoving C licks
To get the best out of VinylStudio's click repair tools, especially on badly damaged recordings, you have to be prepared to put a bit of
time in. On the plus side, VinylStudio provides powerful tools which, when correctly applied, can give excellent results. Also, because
your original recordings are not changed by the repair process, you can always come back later, have another go at the affected area(s)
and then burn a new CD.
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Automated click repair is always a compromise between false negatives and false positives. False negatives are, of course,
undetected clicks and scratches, while false positives cause unnecessary and potentially harmful changes to the original waveform.
VinylStudio's default settings aim primarily to do no damage to the sound quality of your original recordings. While this catches the
majority of clicks, it inevitably means that some slip through undetected; with a bit of manual intervention, these can be removed too.
VinylStudio provides a number of presets designed to work with differing types of source material but it is worth learning more about how
to use the settings themselves if you want to get the best out of your vinyl (or shellac).

VinylStudio's primary setting is sensitivity. We recommend that you perform your initial scan with the default settings and then focus in
on any problem areas. It is unlikely, but not impossible, that sound quality will be adversely affected at these settings. If it is, you can
rescan the affected section at reduced sensitivity or, if appropriate, increase the percussion protection setting; ensure also that brass
protection is enabled. It is more likely however that a few clicks will remain. Rescanning an affected region with a higher sensitivity
setting usually gets rid of any residual clicks, bit with an increased risk of introducing distortion or other artifacts into the sound.
Be particularly careful when using the 'turbo' settings as these can cause distortion and take longer to complete the scan. They are
intended for use on difficult material with a large high-frequency content, such as modern jazz, but as VinylStudio has an undo facility
we encourage you to experiment. The turbo settings are often best used just to scan particularly badly affected areas ('Scan selection').
VinylStudio has three other settings which affect the click repair process:
Percussion protection (PP)
Brass protection (BP)
Number of passes
Percussion protection helps prevent the 'dulling' of percussion sounds that declicking can cause, especially at higher sensitivity settings.
The problem is that percussion bursts, especially the initial 'thwack', look a lot like clicks and therefore VinylStudio wants to fix them. The
downside of having Percussion Protection enabled is that, on occasion, it prevents a legitimate click (or, more likely, a 'scrunch' comprised
of several clicks close together) from being repaired. If you think this might be happening to you, you can either re-scan the affected
area with percussion protection turned down or you can refer to the corrections list to see if percussion protection is operating in the
region in question (if you select the region first, it will be highlighted in the corrections list with a yellow background). For an example of
percussion protection in action, click here.
Brass protection prevents distortion of brass and horn instruments by the declicking process, again principally at higher sensitivity
settings. In severe cases, this can be quite unpleasant, and mainly affects sounds with a buzzing or rasping quality like trombones,
saxophones, trumpets and some synth sounds (and even, occasionally, gravelly vocals). Low frequencies are generally affected most.
Brass protection usually detects sounds such as these and temporarily reduces the sensitivity of the click detector to protect them.
However, like percussion protection, this can let the odd click through and the same recommendations apply. We do not advise turning
off either setting routinely, however.
The number of passes controls the number of times VinylStudio scans the source material. One pass is usually enough, but if a
recording is in very bad condition (particularly if it is badly scuffed) you might find that a second pass helps. You can achieve the same
effect by scanning again with the 'Keep existing scanned repairs' box checked.
You can also repair or adjust clicks manually. While this might sound like a tedious procedure, it is sometimes the only way of eliminating
a particularly severe click. Like other declicking software, VinylStudio sometimes fails to detect something which is (a) annoyingly loud
and (b) usually obvious (fortunately) in the waveform display as a large spike. Finding and repairing such a click manually is quick and
easy. Please refer to the manual click repair help page for more details.

C leanup Audio - P ercussion P rotection
Percussion protection helps prevent the 'dulling' of percussion sounds that declicking can cause, especially at higher sensitivity
settings. This happens when VinylStudio concludes (wrongly) that the sharp 'attack' sound of a piece of percussion is a click. This
problem is not unique to VinylStudio - other click repair programs are affected in the same way.
Percussion which has been affected in this way usually shows up in the corrections list as a large number of wide clicks (coloured red),
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especially in loud passages of music. And not only percussion is affected: here is a section of bass guitar, scanned with percussion
protection turned off:

As you can see, the corrected (green) trace is missing a lot of the detail present in the original (gray) trace. The result is a dulling of the
sound, often unnoticeable but not always. Here's what it sounds like (to hear the difference clearly, you may need to use headphones):

Original:

Dulled:

Although we have had to compress these sound samples to reduce the filesize, you can still hear that the 'attack' sound of the bass
player's fingers plucking the strings has been lost, which is a shame. If you encounter this kind of problem, you can re-scan the affected
area with a higher percussion protection setting, reduce the sensitivity or, if the music is click-free in that area, just use the Remove
Corrections option to remove all repairs made by VinylStudio. If you have the patience, you can even delete individual repairs.
In many cases however, percussion protection does its job. Here is a screenshot of the above example with percussion protection
enabled:

And as a result, the original sound is restored:

When to turn Percussion Protection Up
The default Percussion Protection setting is set fairly low to avoid clicks from slipping through. If your recording is in reasonable
condition, you can probably benefit by using a higher setting than the default. If you are prepared to put some time in, first try the
maximum setting as this gives the best sound quality, but be prepared for the odd click to slip through. When this happens, rescan just
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the affected area at a lower setting. And you can always use 'undo', of course. Preserving the quality of the music while putting up with
the occasional click is sometimes the best compromise.
The corrections list can help you identify sections of music where percussion protection is active (or not).
When to turn Percussion Protection Off
Percussion protection works less well on recordings with a lot of 'scrunches' (i.e. short bursts of clicks in rapid sequence) or scuffs as
these look a lot like percussion and can therefore escape detection, so if you are attempting to restore a scratchy old 78 you will
probably get better results with percussion protection turned down or turned off. Here is an example where percussion protection has got
it wrong (we deliberately used a higher than normal setting to provoke this):

Although the waveform looks like a piece of percussion, it is in fact a scuff on the record surface. In this case, the problem can be
resolved by scanning with percussion protection turned to a lower setting:

C leanup Audio - Brass P rotection
Brass protection prevents distortion of brass and horn instruments that can be introduced by the declicking process, principally at
higher sensitivity settings. This problem (which is not unique to VinylStudio) can, in severe cases, be quite noticeable as the following
example shows. Notice the grey areas in the waveform display, which indicate a large number of click repairs in the regions affected (it's
not normally this bad - we scanned this sample at maximum sensitivity with brass protection turned off to highlight the effect):

The result sounds like this (the difference is clearer on headphones):

Original:

-- 37 --

Distorted:

If we zoom in, we can see what is going on (just to remind you, the green trace is the corrected waveform and the grey trace is the
original):

As you can see, the 'spikey' nature of the waveform has fooled the click detector which has therefore made undesirable changes to the
music - it doesn't look like much, but then it doesn't take much to be audible. VinylStudio's unique brass protection feature is designed to
combat this problem by reducing the sensitivity of the click detector in passages of music such as this. Here is the same file scanned
with brass protection enabled:

And in closeup, you can see that the original waveform has been restored (or, rather, left unchanged):

And as a result, the distortion is eliminated:

Brass protection becomes somewhat less effective as the sensitivity is increased, so if a section of your music does sound distorted, or if
there are a lot of solid grey areas on the waveform display, try scanning the affected section at reduced sensitivity (although, it should
be noted, some forms of distortion present in the original recording can actually be eliminated by scanning at higher sensitivity, so don't
-- 38 --

be afraid to experiment).
When to turn Brass Protection Off
Actually, almost never. It rarely causes problems and frequently protects your music from damage, especially at higher sensitivity
settings. The most likely problem you are liable to encounter is an unrepaired severe click in a passage of, say, saxophone music, and it is
often quicker and easier to repair such a click manually. However, if you have a recording in very bad condition which consists largely or
entirely of 'mellow tones', you might get better results with brass protection turned off.

C leanup Audio - P atching Bad Scratches and Dropouts
(VinylStudio Pro only).
If your recordings contain scratches or dropouts which are too wide for VinylStudio's click repair capabilities, you can use the Patch
command instead. This can patch upto 1/4 second (250ms) of audio by reconstructing the damaged section from the music on either
side of it.
To patch a section of music in this way, first select it (by clicking and dragging in the waveform display) and then click on the Patch
selection button
in the toolbar beneath the waveform display in the Cleanup Audio window. This displays the Patch dialog:

Click on Preview to hear how the patched section will sound, or on Play Original to hear the original, unpatched version. You can try
the various patch methods in turn to see what sounds best, although APA is usually a good bet. You can also adjust the selection by
dragging either edge to select the damaged area precisely, then click OK to apply the patch permanently or Cancel to discard it.
Note that all of the controls in the toolbar are active while the Patch dialog is open, and that you can undo a patch after you close this
dialog if you decide you don't like it.
To delete a patch, right-click on it in the corrections list and then select Delete Patch. You can also delete a patch by selecting it in
the list and pressing Del
You cannot adjust the width of a patch directly, but if you first delete it you can then adjust the selection and repatch it. Alternatively,
just place another patch over the top.

C leanup Audio - R epairing C licks Manually
(VinylStudio Pro only).
If VinylStudio fails to find a particularly irritating click, first try selecting the offending section of music (by clicking and dragging in the
waveform display) and then scan it with more aggressive settings. This usually does the trick, but if it doesn't, you can repair the click
manually. Manual repairs can be fairly wide - up to 400 samples - but if you need a wider repair (for a bad scratch or scuff mark, say),
try using patch instead.
The hardest part of the job is locating the click (although this gets easier with practise). Really bad clicks and scratches (which can be
hard for the software to detect, surprisingly) are usually visible in the waveform display as a large spike. To find them, define a selection
encompassing the offending section of music as closely as possible, then zoom in on it
and play the selection
, watching the
cursor and listening carefully (wearing headphones helps a lot). Zoom in again, if need be, and repeat the procedure. When you are
zoomed in close enough, most big clicks usually become clearly visible, like this:

Once the click is located repairing it is easy. Click on the click (so to speak), zoom in until the background of the display lights up
(refining the cursor position as necessary along the way) and then click on the Insert Manual Repair button
. You will then see
something like this:
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Notice how different (and massive) the click looks in closeup - its unusually broad shape is why it was not detected by scanning. Note
also you repair each channel separately. To finish up, drag the edges of the repair to completely cover the damaged area, making sure
that the repair is wide enough:

Et voila! The resulting repair is usually completely inaudible, but if not there may be another one close by so zoom out a little and have a
more careful look. Ensure also that you have repaired both channels if, as is common, the click affects both.
You can adjust the width of an automatic repair in the same way. This can be useful if, as occasionally happens, VinylStudio has not
removed the click entirely. To select a repair, you can click (or double-click) on it in the corrections list or zoom in close and click on it in
the waveform display. In either case, make sure that the Show Clicks box is checked, and again you do this for each channel
serparately.
Here is an example of a click that has been located automatically but only partially repaired:

Close, but no cigar. Although the situation is considerably improved, you can still hear it:

Original:
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Automatic (partial) repair:

To remedy matters, drag the edges of the repair to completely remove the bump in the waveform. You don't need to be shy about this make sure the repair is wide enough to completely remove the click:

The final result is a perfect repair:

Importing, Exporting and C onverting Files - T he File History List
The File History List in the Cleanup Audio window shows all working versions of the currently selected album side, in date order (most
recent last). It is intended mainly for users who wish to import existing files or edit their recordings outside VinylStudio. Otherwise, it is
not normally necessary to save copies of your files as you work because VinylStudio applies all changes 'on the fly' as and when needed.
But if you want to work on a file in another program, and you want that program to use any changes made inside VinylStudio, then you
will need to save or export a copy first.

To import an existing sound file, right-click in the File History List and select Import Sound File. You can elect to leave the file where
it is, or to copy or move it into VinylStudio's recordings folder. Note that this only works if you have created an album in the Record
window. See Importing Existing Recordings for some additional information.
To save a copy of a recorded album side, right-click in the File History List and select Save a Copy. You can either save a copy in
VinylStudio's recording folder or to another folder of your choice. If you want to save a copy VinylStudio's recording folder you have to
stick to VinylStudio's file naming conventions as described below.
You can also convert recordings from one file format to another, rename or delete saved copies, and, if desired, use the Set as Default
menu option to specify that CDs should be burned from something other than the most recently saved version (as indicated by a '>'
symbol in the list). All of these options are available by right-clicking in the list.
Editing Files Outside VinylStudio
To export a file for editing in another program, we recommend saving a copy in WAV format, as this is the format that most such editors
are designed to use. Then, when you subsequently edit the file in (say) Audacity, you can simply overwrite it. You may need to shut
down VinylStudio (or select another album from the dropdown list) before you can save the file.
If you save a copy to another folder, you can use whatever filename you like. This is probably the easiest (or at least the most familiar)
option for most users.
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Alternatively, you can save working copies in VinylStudio's recordings folder. When you do this, VinylStudio requires you to use its own
naming conventions; you will be prompted for a suffix which is appended to the name of the original file, so that the saved copy might be
called, for example:
Elton_John~Greatest_Hits~side1_copy.wav
Please note the squiggles and underscores used in the actual filename.
If you want to make a second copy of such a file outside VinylStudio (or, indeed, a copy of the original recording), you can do so by
saving the file with a new suffix, e.g.
Elton_John~Greatest_Hits~side1-edited-in-Audacity.wav
Then, provided that you stick to the naming convention that VinylStudio understands, VinylStudio will pick up the latest file when you
select Check for Changes from the Album menu.
For reference, the naming convention that VinylStudio uses for recorded album sides is:
Artist~Album_title~side1<optional suffix>.wav (or .mp3)
Artist~Album_title~side2<optional suffix>.wav
etc.
If you use an external encoder to generate MP3 files, we recommend using Variable Bit Rate (VBR) encoding as this gives the best
quality for the minimum file size. Most MP3 encoders include such an option, and will do so by default if you specify different minimum and
maximum bitrates for the encoded files.

Burn CDs / DVDs

In the Burn CDs window, you can burn both Audio and MP3 or other data CDs from your recorded albums. To do this:
1. Select Audio CD, Data CD or Data DVD as desired.
2. Drag albums or individual tracks from the left-hand pane to the right-hand pane (the 'burn list').
3. Click Burn.
VinylStudio can burn data CDs and DVDs containing a variety of file formats. To select the file format and compression / encoding
options, click on the Options button.
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Audio CDs will play on any CD player and can accomodate about an hour's worth of music. MP3 CDs can store roughly 7 hours of music
but will work only on players specifically designed to play them. Data CDs burned using other file formats usually needs to be played on
specialist players; the amount of music you can fit on depends on the file format and compression options used.
To locate an album quickly, click anywhere in the left-hand pane and then type in the first few characters of the artist's name. You
can also select more than one item at a time (albums and/ or tracks) by clicking while holding down the Ctrl key, and you can select a
range of items by clicking on the first, then hold down the shift key and click on the last.
To delete tracks from the burn list, select one or more tracks and then right-click on any one of them. You can also move tracks
within the list (providing the selection is a single block) by clicking and dragging. Again, to select more than one track hold down the Ctrl
key, and to select a range of tracks, click on the first and then shift-click on the last.
VinylStudio displays the total size of the tracks in the burn list and the amount of free space on the CD or DVD in the drive (if any).
If the total size of the tracks in the burn list exceeds the free space on the CD, the display will turn yellow; you will only be able to burn
the disc if you erase it or insert a new, blank disk. If the tracks exceed the capacity of the CD, the display turns red; you will not be able
to burn a disc until you remove some tracks from the burn list or insert higher capacity media. If no media is inserted, or if VinylStudio
cannot determine its capacity, the available space is shown in black (best guess).
If you wish to change or eliminate the usual 2 second gap between tracks on Audio CDs, you can do so in the CD Burning Options
dialog, but be aware that not all CD players can play such discs properly. You can also tell VinylStudio which size of media you are using
in this dialog.
If you wish to print a CD cover or label, you can export a track listing to a file in a format that most CD cover editors can read. Please
note that this feature is available in VinylStudio Pro only. For more information, click here.
If you encounter problems burning CDs, ensure that there are no other CPU-intensive applications (such as games) running. You may also
find it helpful to reduce the Write Speed in the CD Burning Options dialog. If this does not rectify matters, please contact AlpineSoft
technical support for advice.
VinylStudio will automatically update the album status for each album burned to CD (even if you just burn a single track).
Please note that if you are using VinylStudio Lite you may be unable to burn data CDs or DVDs. To upgrade, select Upgrade to Full
Version from the Help menu.
You can do other things, such as recording another album, while the CD is being written.

Burning Multi-Session C Ds
VinylStudio now has improved support for burning multi-session data CDs. This allows you to add tracks to a CD you burned previously,
provided that the CD is not already full. This only works for data CDs, not audio CDs. Once you have burned an audio CD, that's it.
When you are adding tracks to a disc you have burned previously, VinylStudio might report that there is not enough space on the CD to
fit on all the new tracks. You can avoid this problem by putting the CD in the drive before you start dragging tracks across to the burn
list. It takes a few seconds for VinylStudio to notice that you have inserted a disc but it will then display an updated 'percentage full'
figure (possibly now greater than 100%) which allows for the space already used on the CD. Make sure that this figure is below 100% (by
deleting tracks from the burn list if necessary) before trying to burn the CD.
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Please note that if you burn the same track to a CD twice it will appear on the CD twice (with different sequence numbers). Note also
that multi-session discs burned on the Macintosh cannot be read by Windows, or by most domestic CD or DVD players.

W hy do my C Ds not P lay in my P layer?
One reason is that you might have burned an MP3 or other data CD. Most older CD players will only play audio CDs.
Another reason might be your choice of media. Try using 74 minute / 650MB blanks rather than the more common 80 minute / 700MB
variety. The smaller capacity discs are more compatible with older CD players because they have a wider 'groove'. You will probably have
to get them by mail order.
Please note also that rewriteable CDs (CD-RW's) will not play in some players.

W hy is T here no T rack Listing Displayed in W indows Media P layer?
VinylStudio can now write track listings to Audio CDs (so-called 'CD-Text') but in order to see them in Windows Media Player you need to
download a free plugin called WMPCDText from bmproductions.fixnum.org. If you are installing this on Vista, don't worry about the
'unable to find Windows Media Player' message: just carry on and everything will work out fine. Please note that for reading CD-Text on
Windows XP (but not on Vista), administrator rights are required.
Please note also that track names on audio CDs are truncated at 31 characters. This is a limitation of the burning engine we use
(StarBurn) and cannot be changed, sorry.

Export C D T rack Listing
(VinylStudio Pro only).
If you would like to print a CD cover or label for CDs burned in VinylStudio, you will need to purchase a third-party editing program such
as CD-Cover Editor or Easy Cover Design Pro or the CD Cover designer included in the Nero Burning Rom suite. All of these programs (and
most others of a similar nature) can import a track listing from a suitably formatted file, and VinylStudio can create such a file from the
tracks present in the burn list (i.e. the tracks you have most recently burnt, are burning, or are about to burn to CD).
To do this, click on the Export Track Listing button in the burn CDs window and follow the on-screen instructions. If in doubt, export an
M3U file as most programs can read these. Then import the file VinylStudio creates into your CD cover editing program as follows:
CD-cover Editor (which imports M3U files):
right-click anywhere on your design
select 'Insert Object', and then 'Tracklist'
click on the 'Import from Playlist' button
select the file you exported from VinylStudio
Easy Cover Design Pro (which also imports M3U files):
click on 'Edit Tracks' in the toolbar on the left-hand side of the screen
click on the 'Import Playlist' button
select the file you exported from VinylStudio
Nero Cover Designer (which imports CDC files):
click 'Data' in the menu bar and select 'Document Data' from the dropdown menu
click on 'Disk 1'
click on the 'Import Data' button
select the file you exported from VinylStudio
click OK
The only mainstream CD cover editor we know of that cannot import a track listing in this way is AudioLabel. Future versions of
VinylStudio will include track information on audio CDs, which should resolve this problem. Track information is already included on MP3
CDs and again, most CD cover editors (including AudioLabel) can read this information from the CD.
Please note that you cannot export track listings in VinylStudio Lite. To upgrade, select 'Upgrade to Full Version' from the Help menu.

C D / DVD Burning O ptions
To access the burn settings dialog, select CD / DVD Burning Options from the Options menu, or click on the Options button in the Burn
CDs window:
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CD / DVD Drive selects your CD burner. There will normally be only one.
Burning Engine can be used to select IMAPI if StarBurn fails for any reason. Such a failure is rare, and StarBurn is more functional and
reliable.
Media Size can be used to specify the size of media you are using (CD or DVD). Alternatively, insert blank media into your drive before
you start dragging tracks across to the burn list. VinylStudio will then calculate the available space automatically.
Write Speed allows you to reduce the write speed. This is normally unnecessary but with some burners, discs written at lower speeds
can be played on a wider variety of players.
Write Mode allows you to force VinylStudio to use a particular write mode when burning audio CDs. VinylStudio normally selects the best
method for your particular drive automatically but it can be useful to be able to override this setting for certain drives. The Disk-at-once
methods produce the most compatible discs, and you must select Disk-at-once Raw PW (or Automatic) to write track listings to CD.
Gap between tracks on audio CDs: this is normally 2 seconds but you might like to experimant with 'gapless' CD's if you are recording
live albums. Please note however that not all players can play such CDs reliably.
File Format for Data Discs: select the file format (e.g. MP3) for files written to data discs. To change compression and encoding
options, click on the File Options button.
Include album and track information on audio CDs ('CD Text'): writing this information to audio CDs is normally safe enough but
many CD players do not display it. For details on how to display these listings in Windows Media Player, click here.
Enable buffer underrun protection and Perform OPC check should normally be enabled. These option is provided in case using these
features causes problems with your particular CD drive.
Finalize Data CDs should not normally be enabled, but a few players will only play finalized discs. You cannot add any more tracks to a
finalized disc, even if it is not full.
Include in Filenames on Data Discs:
Track number: ensures that the tracks on the CD or DVD remain in the order they appear in the burn list; if you uncheck this box,
they will appear in alphabetical order.
Artist: names tracks on the CD in the form Artist - Track Title
Album Title names tracks on the CD in the form [Artist -] Album Title - Track Title

Batch Operations (VinylStudio Pro only)
Clicking on the Batch tab will take you to the Batch window. In this window, you can:
Save tracks for several albums at a time
Copy these files to your MP3 Player or iPod
Import these files into your Windows Media Player library
Declick some or all of your albums in 'batch' mode
Normalise some or all of your albums in 'batch' mode
Convert existing recordings to other file formats
Delete multiple albums or album components from your collection
Change the status of multiple albums
Move or copy albums between collections
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Print part or all of your collection

Saving T racks
Please note that Batch operations are available only in VinylStudio Pro. To save your tracks in VinylStudio Standard (and VinylStudio
Lite), click on the Save Tracks button in the Split Tracks window.
VinylStudio can generate files in many formats, one per track, for any or all of the albums in your collection. These can then be played in
Windows Media Player or iTunes, or copied out to your MP3 player or memory stick. Formats supported are MP3, WAV, AIFF, FLAC, OGG
and, on Windows only, WMA. On the Macintosh, VinylStudio can also save tracks in AAC (MP4) and Apple Lossless (ALAC) format. These
are the file formats favoured by iTunes (although iTunes can also play MP3 files perfectly well). Note that you can save your tracks in
any format (or multiple formats), regardless of the format you recorded to.
Select the albums you want to save and then click on the Save Tracks button. The process may take a while, although VinylStudio will
skip any tracks that have been saved before (unless they have changed). To force VinylStudio to save all tracks regardless, check the
'Always save tracks, even if saved before' box. You can also save individual tracks by selecting Save Track As from the Track menu in
the Split Tracks window.
By default, saved tracks are saved in the following folder:
Music
<Name of your collection>
You can change this in the Settings dialog under the Options menu. You can also browse the folder from this dialog and you can
change settings used for file encoding (e.g. the level of compreesion to be used) when saving tracks.
VinylStudio will automatically update the album status for each album saved to help you keep track of your work.
Please note that if you are running VinylStudio Lite this feature may be unavailable. To upgrade, select 'Upgrade to Full Version' from the
Help menu.
Tip: to select several albums in a block, click on the first (make sure it is ticked) and then shift-click on the last.

Saving T racks in DSD Format
Starting in VinylStudio 8.6, you can save your tracks as DSD files provided you recorded to DSD format in the first place. To do save as
DSD, tick the 'Save DSD recordings as DoP' checkbox in the confirmation dialog displayed when you save your tracks or choose a 'native'
DSD format (.dff or .dsf). Files saved as DoP are stored in standard WAV, AIFF, FLAC, CAF or Apple Lossless files and can be played back
directly by a compatible DAC.

C opying Files to your M P 3 P layer or iP od
To copy tracks to an iPod, iPad or iPhone, use iTunes. You will need to save your tracks first as described above.
To copy tracks to an MP3 player, first save them as MP3 files as described above. Then plug your MP3 player (or memory stick) into a
USB port and click on the Copy to Player button. VinylStudio then displays the following dialog:
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VinylStudio displays a list of drive letters which it thinks might be MP3 players or memory sticks. Select the one you want from the list
and VinylStudio will then open two Explorer windows side-by-side, with your saved tracks on the left and your MP3 player on the right.
You can then drag and drop files from one to the other in the usual way:

When dragging files across, be careful not to create too many folders on your MP3 player. Many players have a fairly low limit (10 or so)
on the number of folders they can handle.
If you want to know how much space is left on your MP3 player, right-click in an empty part of the right-hand pane and select
Properties.

P laying Files in W indows Media P layer
There are two approaches to this: you can either have VinylStudio generate playlists, one per album, or you can import the MP3 files you
have generated into Media Player's library directly.
To create playlists, select the Create Playlists for Windows Media Player option from the File menu. VinylStudio will then generate a
playlist for each album in your collection and store them in the following folder:
Music
<Name of your collection>
Playlists
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(You can change this folder from the Settings dialog under the Options menu).
You can then open or import these playlists into Media Player in the usual way. They have the advantage of maintaining the identity of
the albums in your collection.
To import your MP3 files directly into Media Player's library (which is the more common approach), click on Media Player's Library
tab, and then on Add to Library. Alternatively, you can tell Media Player to monitor your My Music folder. Then, all MP3 files that
VinylStudio (or any other program) generates in that folder - or any folder below it - will be added to the library automatically. This is the
default for Media Player 12 and later. To see what folders Media Player 12 is monitoring, click on Organise, and then Manage Libraries Music.

Batch Declick
To declick some or all of your albums in a single operation, select the ones of interest in the list and then select Scan Selected Albums
for Clicks from the menu under the More button. You will be prompted for the scan settings to be used and then VinylStudio will perform
the scan. For more information on what the various scan settings do, please refer to the Scan for Clicks help topic. Each album side
takes about 1 minute on a modern computer.

Batch Normalisation
To normalise some or all of your albums in a single operation, select the ones of interest in the list and then select Normalise Selected
Albums from the menu under the More button. You will be prompted for the volume level to be used and then VinylStudio will set to
work with no further manual intervention required. Processing time varies depending on what filters you have selected for the albums in
question. The Hiss filter is particularly CPU-intensive.

Batch File C onversion
VinylStudio can convert existing recordings from one file format to another. You might, for example, have recorded or imported your
recordings in WAV format but now wish to convert them to FLAC format to save disk space. You can do such conversions in this window
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- just select the albums you want to convert in the list and then select Convert Recording Format of Selected Albums from the menu
under the More button.

Deleting Multiple Albums or Album C omponents
To delete multiple albums at a time from your collection, select them in the list and then select Delete Selected Albums or Album
Components from the menu under the More button.

In addition to deleting the albums themselves, you can elect to just delete certain components, such as your 'raw' recordings, while
retaining the albums themselves in your collection as a reminder of what you have done. If you are exporting tracks to iTUnes, there is
some mileage in deleting the tracks saved by VinylStudio, as these are duplicates of the copies stored in the iTunes library.
If you have plenty of disk space, consider keeping your albums around. That way, you can always save your tracks again if you need
them in another format, for example.

C hanging the Status of Multiple Albums
You can use the album status to keep track of the stage you have reached working on a particular album or albums. To change the
status of multiple albums at a time from your collection, select them in the list and then select Set Status of Selected Albums from the
menu under the More button.

VinylStudio supports upto 5 'custom' status settings which you can use for whatever purpose you choose. You can give these names of
your own by selecting 'Set Custom Album Status Names' from the Options menu.

Moving or C opying Albums Between C ollections
This option can be used to merge two or more collections. To move albums from collection A to collection B, proceed as follows:
1. Open collection A (Menu -> File -> Open Collection, or Menu -> File -> Recent Collections).
2. Go to the 'Batch' window.
3. Select the desired albums in the list (or use 'Select All').
4. Under the More button, select 'Move or Copy Selected Albums to Another Collection'.
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5. Navigate to collection B and select your desired options.
6. Confirm that you want to proceed.
VinylStudio will then take care of the rest.
Options available at step 5 are:
Copy albums, rather than moving them.
Link to existing recordings, rather then copying them (if the copy option is selected). This, in effect, shares the recordings
between the two collections.
Delete saved tracks for albums moved or copied. You can then save them again (to a new location, potentially) from the
destination collection.
Generally, moving albums is what you want.

P rinting P art or All of your C ollection
To print part or all of your collection, select the desired albums in the list (or use 'Select All') and then select Print Selected Albums
from the menu under the More button. You can control exactly what is printed in the 'Printing Options' tab.

Importing and Exporting Files
Importing Existing R ecordings
You can import recordings that you have made outside VinylStudio into your collection. To do so, proceed as follows:
Click on the Record tab.
Click on 'Record or import a new album'.
Click on 'Import Sound File(s)'.

Then:
A list of sound files is displayed and you can select one or more to be imported.
You will then be prompted for the album artist and title (required), after which you can import the file or files you selected from the
list.
If you wish to import additional sound files for an existing album, click on Work with an existing album, then select the album from the
dropdown list and click on Import Sound File(s). You can also import files via the File History List in the Cleanup Audio window, where
you can see which files have been imported or recorded previously for a particular album side.
The files you select will, at your option, either be left where they are or copied or moved into VinylStudio's recordings folder. VinylStudio
can import a variety of recording formats.
If you wish to re-import a file that you have edited outside VinyStudio, please refer to the File History List help topic. You can also use
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the File History List to convert between recording formats.
Importing Multiple Files
As of VinylStudio V8.7, you can import several files at once for any particular album. This can be useful where the files are individual
tracks, rather than whole album sides. VinylStudio can insert trackbreaks between the files for you and automatically name the tracks
from the file names.
To import multile files, ctrl+click (or, on the Mac, command+click) or shift+click on the files when they are displayed in the list.
VinylStudio will then take care of the rest. If the files are not in the right order, you can drag them around after you open them (but
before you complete the import).
Please note that to import more than one file at a time, you need VinylStudio Pro.
Importing and Exporting Cue Sheets
VinylStudio can now import albums from cue sheets. Just click Import Cue Sheet and select the file or files you wish to import. The rest
is automatic.
VinylStudio can also generate cue sheets for some or all of the albums in your collection. To generate a cue sheet (or sheets) for a single
album, select Generate cue sheets from the Album menu.
You can also generate cue sheets for several albums at a time in the Batch window. To do this, tick the boxes for the albums you wish
to process and then click on the More button and select Generate Cue sheets for Selected Albums.
Please note that to import or export cue sheets, you need VinylStudio Pro.

Importing C ollections from Discogs
(VinylStudio Pro only)
You can import collections from Discogs saved in XML format. This will create the albums in the file, with a complete track listing for
each, in VinylStudio. To do this, first export your collection from Discogs in XML format to a file somwehere on your hard disk. Then:
1. Select 'Import Discogs Collection' from VinylStudio's File menu.
2. Navigate to the file you wish to import and click Open.
3. Select the albums you wish to import.
4. Click Import.
If the Discogs collection contains track durations, VinylStudio will insert trackbreaks in roughly the right place. It will also import album
notes and cover art, if present.

W here are my Files Located?
This help page covers the following topics
Where are my Split-Up Tracks Stored?
Controlling How Split-Up Tracks are Stored Using Custom Strings
How Singles Tracks are Named
Where are my Recordings Located?
What Files does VinylStudio Actually Create?
Archiving your Recordings
Where are my Split-Up Tracks Stored?
When you save your tracks, they are normally stored in the following folder:
Music
<Name of your collection>
You can change this folder in VinylStudio's Settings dialog (which you will find under the Options menu) and you can browse the folder
from within this dialog.
VinylStudio now offers more flexibility in how tracks are stored within this folder. By default, VinylStudio normally creates a separate subfolder for each album, like this:
Music
<Name of your collection>
Beatles - The White Album
01 - Back in the USSR.mp3
02 - Dear Prudence.mp3
...
In more recent versions of VinylStudio however, albums are grouped in folders by album artist, like this:
Music
<Name of your collection>
Beatles
The White Album
01 - Back in the USSR.mp3
02 - Dear Prudence.mp3
...
You can select (or change) this behaviour using the dropdown in VinylStudio's Settings dialog. There are separate settings for albums
and singles.
-- 51 --

Controlling How Split-Up Tracks are Stored Using Custom Strings
Advanced users, or those who would just to understand a little more about what is going on, might like to peruse or enter custom strings
into the Settings dialog to determine exactly where your split-up tracks are stored. These gives you a high degree of control over where
the saved tracks end up. That said, the preset values in the dropdown lists normally suffice, and option 2 (group tracks by album artist)
is recommended for both albums and singles.
To do this, you use keywords to tell VinylStudio how you want your tracks to be named and grouped into folders. When saving each
track, VinylStudio replaces these with the album title, track title or whatever, as appropriate. The following keywords are available:
[Album Artist]

[Album Side]
[Album Title]
[Track Number]
[Track Title]
[Track Artist]
[Performing Artist]
[Genre]
[Composer]
[Conductor]
[Artist Alias]

[Comment]
[Year]
[Label]
[Grouping]
[File Type]

The album artist, e.g. Beatles. For compilations, we recommend you add the album to your
collection under 'Various Artists' and enter the artist separately for each track. For singles, add the
album to your collection under the name of the performing artist, or perhaps (for a sampler EP) again
'Various Artists'.
The album side on which the track appears, starting from 1.
The album title, e.g. The White album. For singles, this is not normally used when saving tracks but
you will need to enter something when you add the album to your collection, perhaps the name of
the 'A' side, that you will recognise later.
This is the track number on the album, starting from 1. This is useful for preserving the order that the
tracks appear in on the original album. We recommend omitting this keyword for singles.
The title of the track, e.g. Back in the USSR. All tracks must have a title and this keyword is
mandatory.
The track artist, if there is one. If not, this keyword is ignored. For this keyword to work properly,
you should only enter track artist information for compilation albums / EPs.
This is the track artist, if it has one, or the album artist if not. Useful for singles or for grouping all
your tracks by performing artist (if you don't care which album they came from).
The genre you have assigned to the album, if any.
The composer you have assigned to the album or track, if any.
The conductor you have assigned to the album or track, if any.
The artist alias you have assigned to the album or track, if any. You can use this to enter the album
or track artist in an alternative form, e.g. 'John, Elton', which you can then use in the filename of
your saved tracks. For files that use ID3 tags (WAV, AIFF, DSF) this is placed in TSOP ('performer
sort order') tag. For other file formats, there is no tag for this.
The comment you have assigned to the album or track, if any. Use this for anything you like.
The release year of this album, if any.
The 'Label' field in the Edit Album Details dialog.
The 'Content Grouping' field in the Edit Album Details or Edit Track Details dialog.
The file type (e.g. MP3, OGG).

Inserting a backslash (\) specifies a folder rather than a file name. Thus for example:
[Album Artist] - [Track Title]
might result in a file called, Beatles - Back in the USSR.mp3, whereas:
[Album Artist] \ [Track Title]
might generate a folder called Beatles containing a file called Back in the USSR.mp3, like this:
Music
Beatles
Back in the USSR.mp3
How Singles Tracks are Named
By default, all singles tracks (i.e. those for albums where you have told VinylStudio 'This is a single') are saved in a folder called Singles,
like this:
Music
<Name of your collection>
Singles
Elton John - Goodbye Yellow Brick Road
Elvis Costello - Watching the Detectives
Joe Bloggs - Interview with the Dalai Lama
Joe Bloggs - Interview with the Pope
...
In more recent versions of VinylStudio, singles and spoken word material are grouped in folders by album artist, like this:
Music
<Name of your collection>
Elton John
Elton John - Goodbye Yellow Brick Road
...
Elvis Costello
Watching the Detectives
...
Joe Bloggs
Interview with the Dalai Lama
Interview with the Pope
...
...
Again, you can select (or change) this behaviour in VinylStudio's Settings dialog by clicking on the 'For singles' radio button. Note that,
by default, the album title entered is not used when naming the files. It is however included in the files as an ID3 tag.
See also: Recording Singles and 78s.
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Where are my Recordings Located?
It is useful to know where your 'raw' recordings are located if you want to back them up or if you would like to move them elsewhere
(typically to an external hard drive). By default, VinylStudio stores your recordings in the following folder structure:
My Documents
Recordings
<Name of your collection>.mcf
<Name of your collection>
Elton_John~Best_of~side1.wav
Elton_John~Best_of~side2.wav
...

-- a file
-- a folder

Any album art you have downloaded in VinylStudio is also stored in your collection folder (in a sub-folder called artwork).
You can tell VinylStudio where to store your collection when you initially create it and you can open an Explorer window to display the
contents of your recordings folder from within the Settings dialog under the Options menu.
Your collection (.MCF) file stores information about your collection (such as album and track titles), rather than the recordings
themselves. MCF files are precious and we recommend you back them up regularly. They are not very large.
If you want to move a collection from one place to another, it is important to maintain the relationship between the MCF file (e.g. My
Collection.mcf) and the folder containing your recordings (e.g. My Collection). The golden rule is that both of these must reside in the
same parent folder and must both have the same name.
What Files does VinylStudio Actually Create?
In addition to your split-up tracks (which are generated on demand), VinylStudio creates, for example, the following files when you
record an album (these are the 'raw' recordings of the album):
Elton_John~Best_Of~side1.wav (or .aiff, etc)
Elton_John~Best_Of~side2.wav (or .aiff, etc)
...
When you scan an album for clicks, the following files are created in addition (these files contain your click repairs; take care not to lose
them!):
Elton_John~Best_Of~side1.wav.crd (or .aiff.crd, etc)
Elton_John~Best_Of~side2.wav.crd (or .aiff.crd, etc)
...
Any album art you have downloaded in VinylStudio will be stored in a folder called artwork located in your recordings folder, e.g.:
artwork
Elton_John~Best_Of.jpg
Artwork from other sources is left in whatever folder you saved it in when you acquired it. VinylStudio does not alter or delete these files.
Finally, some files used internally are created in folder vsfiles. VinylStudio can regenerate these automatically so you don't need to back
them up (although regenerating the waveform display is rather slow for DSD recordings, so you might like to keep them in that instance):
Elton_John~Best_Of~side1.wav.wfd (or .aiff.wfd, etc)
Elton_John~Best_Of~side1.wav.wfo (or .aiff.wfo, etc)
Elton_John~Best_Of~side1.wav.wfs (or .aiff.wfs, etc)
Elton_John~Best_Of~side1.wav.wft (or .aiff.wft, etc)
...
Archiving your Recordings
You may want to archive some of your recordings to save disk space. You can achieve this by making copies of the recorded WAV (or
AIFF, etc) files and the CRD files containing your click repairs as described above. You can then use the 'Remove Recordings' option in
the Album menu to delete the original files from your hard disk. It is worth retaining the album itself in your collection as this will allow
you to restore the recordings and CRD files at a later date should you wish to work on that album again. If you delete the album from
your collection completely, track names and trackbreak information (and any filter settings used) will be lost. Trackbreak information and
the like is stored in your MCF (collection) file.
Note that deleting your recordings will also delete the CRD files containing your click repairs, so you should archive those first too. It will
also delete the 'waveform' files but VinylStudio can regenerate these automatically so there is no need to back them up (and we
recommend that you don't bother).

Miscellaneous
C onfiguring VinylStudio Settings
VinylStudio's Settings dialog gives you a lot of control over where your split-up tracks are stored and how they are named, as well as
one or two other things. You can access this dialog via the Options menu. You will also find additional, more specialised options under the
Options menu.
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Checking the Autosave box tells VinylStudio to save your work every few minutes automatically (recommended). When it does this,
VinylStudio saves your album and track listings and suchlike in something called an MCF file. We refer to this as your collection file,
although your collection also includes your recordings, album art and any split-up tracks.
Draw waveforms with thicker lines applies to the Cleanup Audio window and can make the waveform display easier to read on some
monitors.
When playing track breaks, play each one for: applies to the Split Tracks window, and sets the amount of audio that VinylStudio
plays either side of each track break when you click the 'Play Track Breaks' button in the toolbar beneath the waveform display.
The folder in which your split up tracks are stored defaults to your My Music folder but you can change this here if you wish. By
default, VinylStudio creates a folder beneath here with the same name as your collection but you can override this if you wish by
unchecking the box.
The way in which your split up tracks are named can also be configured in a very flexible way. Choose an entry from the dropdown
list (recommended) or if you want more control over where the files are stored you can type in a custom string. Note that albums and
singles each have their own separate setting; use the radio buttons to select the item of interest. Changing the setting for albums will
make a corresponding change to the setting for singles, as that is generally what is wanted. If not, change the setting for singles
subsequently.
File Options for the various file types that VinylStudio supports are listed below in alphabetical order. You can select the file type to
configure from the dropdown list which is displayed when you click on the button.
Check Save album art in folder.jpg if you want VinylStudio to copy album art to file folder.jpg when saving tracks. Many media players
recognise this file and will display it when the track is played and Explorer will show it as a folder icon. Note that this option only makes
sense if each album is saved to a separate folder.
Add Silence: use these fields to add silence at the start and / or end of saved tracks. If you set these fields, you should eliminate the
existing gaps between tracks in the Split Tracks window, possibly fading the tracks in and out if there is a lot of background noise.
Detect gapless tracks: if you check this box, VinylStudio will not insert silence across a trackbreak which has no gap between the
tracks.

AIFF File Options
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These are the options you can specify when recording to, converting to, or saving tracks in AIFF format. When saving tracks you can
specify a separate set of options for tracks saved in mono and stereo.
Sample Rate: as described for WAV files. To record DSD, select DSD standard rate (strongly recommended) or DSD double rate, although
VinylStudio will normally set this automatically.
Bit depth: as described for WAV files.
Embed Album Art (when saving tracks): as described for MP3 files.
Write ID3 Tags as Unicode: Use Unicode when writing out the ID3 tags. This gives better results for languages other than English but
may be incompatible with some players.

DFF File Options

These are the options you can specify when recording to, converting to, or saving tracks in DFF format.
DSD Rate: select standard rate or double rate as required, although standard rate is strongly recommended for file size and performance
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reasons. VinylStudio will usually set this automatically. When saving tracks, the only option is 'As recorded'.

DSF File Options

These are the options you can specify when recording to, converting to, or saving tracks in DSF format.
DSD Rate: select standard rate or double rate as required, although standard rate is strongly recommended for file size and performance
reasons. VinylStudio will usually set this automatically. When saving tracks, the only option is 'As recorded'.
Embed Album Art (when saving tracks): as described for MP3 files.
Write ID3 Tags as Unicode: Use Unicode when writing out the ID3 tags. This gives better results for languages other than English but
may be incompatible with some players.

FLAC File Options
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These are the options you can specify when recording to, converting to, or saving tracks in FLAC format. When saving tracks you can
specify a separate set of options for tracks saved in mono and stereo.
Sample Rate: as described for WAV files. To record DSD, select DSD standard rate (strongly recommended) or DSD double rate, although
VinylStudio will normally set this automatically.
Bit depth: as described for WAV files.
Compression: Higher values give slightly smaller files at the expense of longer processing times. Because FLAC is lossless, this setting
does not affect sound quality.
Embed Album Art (when saving tracks): as described for MP3 files.

MP3 File Options

These are the options you can specify when recording to, converting to, or saving tracks in MP3 format. When saving tracks you can
specify a separate set of options for tracks saved in mono and stereo. The options for saving tracks are also used when burning MP3 CDs
and DVDs.
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Sample Rate: as described for WAV files.
MP3 Quality: This allows you to trade off file size against sound quality. Variable Bit Rate (VBR) format files offer significant advantages
over the Constant Bit Rate (CBR) format more commonly used, but a (very) few players have problems playing these. VBR High is
recommended when recording as you want, ideally, perfect fidelity and this setting comes close. VBR Low is generally a good compromise
when saving tracks or burning CDs.
Embed Album Art (when saving tracks): If you have looked up or imported album art for the album you are working on, VinylStudio can
embed this in the files it generates when saving tracks. Most players are fine with this but a few may object so you can disable it by
unchecking the box. VinylStudio can also resize the image it stores in the file and it is generally wise to tell VinylStudio to limit the
resolution to around 400 x 400 pixels. This does not change the original artwork file in any way.
Write ID3 Tags as Unicode: Use Unicode when writing out the ID3 tags. This gives better results for languages other than English but
may be incompatible with some players.

Advanced MP3 File Options

Minimum Bitrate: Set the minimum bitrate to use when encoding VBR or ABR files. This is not normally necessary but a (very) few
players have problems playing files containing low bitrate frames.
Maximum Bitrate: Set the maximum bitrate to use when encoding VBR or ABR files. This is not normally necessary or useful but can
reduce file sizes with some types of music (e.g. heavy metal).
Bit reservoir: Enabling the bit reservoir improves recording quality somewhat, especially when generating CBR files. Recommended.
CRC: Include a checksum in every MP3 frame. This reduces encoding quality slightly and is not normally necessary (or useful).
Copyright: Set the 'copyright' flag in every MP3 frame. This has no other effect.
Original: Set the 'original' flag in every MP3 frame. This has no other effect.
Private: Set the 'private' flag in every MP3 frame. This has no other effect.

OGG Vorbis File Options
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These are the options you can specify when recording to, converting to, or saving tracks in OGG format. When saving tracks you can
specify a separate set of options for tracks saved in mono and stereo. The options for saving tracks are also used when burning MP3 CDs
Sample Rate: as described for WAV files.
MP3 Quality: This allows you to trade off file size against sound quality. Variable Bit Rate (VBR) format files offer significant advantages
over the Constant Bit Rate (CBR) format more commonly used, but a (very) few players have problems playing these. VBR High is
recommended when recording as you want, ideally, perfect fidelity and this setting comes close. VBR Low is generally a good compromise
when saving tracks or burning CDs.
Embed Album Art (when saving tracks): as described for MP3 files.
Advanced OGG File Options

Minimum Bitrate: Set the minimum bitrate to use when encoding ABR files. This is not normally necessary or useful.
Maximum Bitrate: Set the maximum bitrate to use when encoding ABR files.

WAV File Options
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These are the options you can specify when recording to, converting to, or saving tracks in WAV format. When saving tracks you can
specify a separate set of options for tracks saved in mono and stereo. Not all players can read the tagging information or album art that
VinylStudio puts in WAV files, and not all players can play RF64 files.
Sample Rate: When recording, 44kHz is recommended as this provides the best results when burning CDs and is generally more than
adequate for digitising records and tapes. When saving tracks, sample rate 'as recorded' is normally what you want but VinylStudio can
convert your saved tracks to a different sample rate if desired. Lower sample rates give smaller file sizes but you will lose some treble.
Converting to higher sample rates generally serves no useful purpose.
To record DSD, select DSD standard rate (strongly recommended) or DSD 2x double rate, although VinylStudio will normally set this
automatically.
If you have an ADC capable of supporting DSD over PCM and you wish to record in DSD format, select DSD in this dropdown.
Bit Depth: The number of bits per sample in the output file. 16 bits per sample is normal. Higher bit depths generate larger files and take
longer to process but give a wider dynamic range if you have a 20 or 24 bit sound card or other audio device.
Embed INFO tag: Embed tagging information as an INFO tag. Not many players read this tag and it cannot include album art.
Embed ID3 tags: Embed tagging information as ID3 tags. This can include album art.
Embed Album Art : as described for MP3 files.
Write ID3 Tags as Unicode : as described for MP3 files.
Write RF64 files (if larger than 4GB): If you check this box, VinylStudio can write WAV files larger than 4GB (so-called RF64 files). Not
all players can read these files, but if none of your saved tracks are larger than 4GB in size then this shouldn't be a problem. Please note
this requires VinylStudio Pro.

WMA File Options
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These are the options you can specify when saving tracks in WMA format. You can specify a separate set of options for tracks saved in
mono and stereo. WMA cannot be used as a recording format.
Profile: A dropdown list of what the available codecs installed on your machine can do. Note that most hardware players do not support
WMA Professional or WMA Lossless.
VBR Quality: Move the slider to the right for better sound quality (and larger files) when using VBR encoding.
Embed Album Art : as described for MP3 files.

Limitations in VinylStudio Lite
VinylStudio Lite is intended to record, split tracks and burn audio CDs. The audio cleanup tools are functional but you will not be able to
burn corrected (i.e. cleaned up) audio to CD.
The following other features are also unavailable:
saving tracks as audio files
burning MP3 CDs
burning DVDs
exporting track listings (for creating CD covers)
recording to FLAC, CAF or Apple Lossless format
'batch' format conversions
To do these things you must upgrade to the full version, which you can do from VinylStudio's Help menu.
The version of VinylStudio Lite supplied with the NAD PP-3 or PP-4 can only record from those devices via the USB port. If this causes
you a problem, please get in touch. It can, however, export track listings for creating CD covers.

P urchasing and R egistering VinylStudio
VinylStudio is shareware, and you can download a trial copy from www.alpinesoft.co.uk/VinylStudio. The trial copy will record a maximum
of 5 albums. You can obtain a license key which unlocks the software for a modest fee by selecting Register from the Help menu within
VinylStudio.

C ustom T ags Editor
The custom tags editor allows you to create whatever tags you like, both at the album level and the track level. Use these to add tags
that VinylStudio doesn't directly support or to keep track of your work. Please note that not all players display these tags for all file
types. You can also specify values for tags that VinylStudio would normally generate automatically. If you do this, your custom tag(s)
take precedence.
You can specify the following keywords in the value field:
[Date Recorded]
[Time Recorded]

The date this album was recorded, in the form dd-Mmm-yyyy (e.g. 01-Jan-2021).
The time this album was recorded, in the form hh:mm (24 hour clock, e.g. 21:30).

You can also use any of the keywords listed under Controlling How Split-Up Tracks are Stored Using Custom Strings.
Here is a list of tags that VinylStudio normally generates automatically. You can override these here. For a full list, please refer to the ID3
specification.
ID3 tags (as used in MP3, AIFF, WAV and DSF files):
COMM

Comment

TALB

Album title

TCOM

Composer

TCON

Genre

TENC

Encoder (normally written as 'VinylStudio')
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TIT1

Content grouping

TIT2

Track title

TPE1

Artist (for the track, if any, else for the album)

TPE2

Album artist

TPE3

Conductor

TPUB

Label ('publisher')

TRCK

Track title

TSOP

Artist alias

TYER

Release year (yyyy)

MP4 tags (as used in AAC and Apple Lossless files). Please note that most of these have a leading space:
alb

Album title

ART

Track artist

cmt

Comment

day

Release year (yyyy)

gen

Genre

grp

Content grouping

nam

Track title

too

Creator (normally written as 'VinylStudio')

wrt

Composer / conductor (composite)

aART

Album artist

Vorbis tags (as used in Ogg and Flac files):
ALBUM

Album title

ALBUMARTIST

Album artist

ARTIST

Track artist

COMMENT

Comment

COMPOSER

Composer

CONDUCTOR

Conductor

CONTACT

Contact

DATE

Release year (yyyy)

GENRE

Genre

GROUPING

Content grouping

LOCATION

Collection name

ORGANIZATION

Label

TITLE

Track title

TRACKNUMBER

Track number (1..)

WMA tags:
Author

Album or track artist

Description

Comment

Title

Track title

WM/AlbumArtist

Album artist

WM/AlbumTitle

Album title

WM/Composer

Composer

WM/Conductor

Conductor

WM/ContentGroupDescription Content grouping
WM/Genre

Genre

WM/Publisher

Label ('publisher')Genre

WM/ToolName

Creator (normally written as 'VinylStudio')

WM/TrackNumber

Track number (1..)

WM/Year

Release year (yyyy)
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DFF tags:
DIAR

Album / track artist (composite)

DITI

Track title

Support and Feedback
If you encounter a problem with VinylStudio, or if you have any comments or suggestions, you can get in touch with us by selecting
Support and Feedback from the Help menu within VinylStudio, or you can contact us through our website.
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